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Preface

This is a guide for system administrators. It provides information about all installation and configuration steps to setup the RiskVision solution and
enable user access.
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Document Conventions

The following conventions are used to help the user identify certain types of information.

Convention Usage

bold Command names, options, window, and screen objects such as buttons and links (for example, the OK
button).

italics Variable information, wizard page names, and book titles.

monospace File names, attributes path names, and programs.
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Special Icons

In this document, icon graphic symbols are used to indicate special notes or specific information. The following table shows the type of information
that each icon represents:

Alert Labels Usage

Warnings
For important instructions, cautions or critical

information.

Tips or

information
For tips, shortcuts, or other helpful product information.

Notes For notes or recommendations.
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Terminology

JasperReports Server is a business intelligence product of Jaspersoft Corporation. It is integrated with RiskVision to compile data into a compact
report. JasperReports Server will be referred to as either JasperReports Server or RiskVision Report Server.
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Resolver Support and Professional Services

Resolver offers both Professional Services and Customer Support to assist customers at every stage of the application’s lifecycle. This support
includes the initial deployment, future expansion or migration, and ongoing use of the platform.

For customers looking to design and configure a tailored security risk and compliance management solution, Resolver Professional Services can help
with installation and configuration, content development, automation options, process development, and report design. For more information or to
inquire about a Resolver Professional Services engagement, please contact your Resolver Customer Support Representative.

Resolver Customer Support can assist the user with any product questions and resolve issues that may have occurred with the RiskVision
deployment.
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Resolver Technical Publications

If any additional information about the Resolver RiskVision is needed, the following additional documentation manuals and guides are available for
customers to view:

RiskVision Installation and Configuration Guide

RiskVision Upgrade Guide

RiskVision Administrator's Guide

RiskVision Compliance Manager User's Guide

RiskVision Enterprise Risk Manager User's Guide

RiskVision Incident Manager User's Guide

RiskVision Policy Manager User's Guide

RiskVision Threat and Vulnerability Manager User's Guide

RiskVision Vendor Risk Manager User's Guide

RiskVision Questionnaire Responders Guide

RiskVision Analytics Guide

RiskVision Connector Reference Guides (provided for individual connectors installed in your environment)

These documents are available within RiskVision. In the RiskVision application, go to Administration > Server Administration and then click the
Documentation tab.
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Jaspersoft Documentation

Jaspersoft documentation is available on the Windows start menu:

RiskVision Report Server - Start > All Programs > RiskVision Report Server > JasperReports Server Documentation
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Resolver Customer Support Portal

For customer support for Resolver RiskVision, visit the Resolver Customer Portal, where you can access release notes, documentation, content
packs, news and announcements, or create a ticket.
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RiskVision and Jaspersoft

This section covers the features Charts, Dashboards, Report Templates, JasperReports Server: Table, Chart, Crosstab, Report Conversion, and
Updating the Customized Labels in a Jaspersoft Domain
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Import or Export Jasper Reports

Users can import and export Jasper Reports data through the user interface or via command line.

Import or Export Data Through the UI

To import data using the Server Settings:
1. Navigate to http://[localhost]:8480/jasperserver-pro/.

2. Log into Standalone as sysadmin.

3. Click Manage > Server Settings > Import.

4. Select the data you wish to import, then click Import.

To export data using the Server Settings:
1. Navigate to http://[localhost]:8480/jasperserver-pro/.

2. Log into Standalone as sysadmin.

3. Right-click the report you wish to export, then click Export.

Yo u  c a n  a l s o  e x p o r t  r e p o r t s  b y  r i g h t - c l i c k i n g  t h e  r e p o r t  i n  J a s p e r  R e p o r t s ,  t h e n  s e l e c t i n g
E x p o r t .

To export report data using commands:
1. Navigate to the \buildomatic  directory.

2. Run one of the following commands:

To export a report or object data, such as data source, input control, image, etc.:
To retrieve the report or object data in a .zip file: js-export --uris /organizations/Agiliance/Reports/ --
output-zip report.zip

To retrieve the report or object data in a folder structure: js-export --uris /organizations/Agiliance/Reports/
--output-dir report

To export the entire repository:
To retrieve repository data in a .zip file: js-export --everything --output-zip repository.zip

To retrieve repository data in a folder structure: js-export --everything –output-dir repository

To import data into the repository using commands:
1. Navigate to the \buildomatic  directory.

2. Run one of the following commands:

To import data via .zip file: js-import --input-zip .zip

To import the report or object data in a folder structure: js-import --input-dir ;

N o t e ,  y o u  m a y  a d d  --update  a t  t h e  e n d  o f  e i t h e r  o f  t h e  p r e v i o u s  c o m m a n d s  i n
t h i s  s t e p  t o  o v e r w r i t e  e x i s t i n g  i m p o r t e d  d a t a  w i t h  n e w l y  i m p o r t e d  d a t a .
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Create a Role in Jaspersoft

To create a new role in the Jasper Reports server:
1. Login to Standalone as sysadmin.

2. Navigate to Manage > Roles > Add Role...

3. Enter a name for the role in the Role Name field, then click Add Role to Agiliance. Spaces and special characters are not permitted.

4. In the Properties section to the right, select the RiskVision users to add to the role from the Users Available pane, then click the > arrow to
add the users to the Users Assigned pane. To remove users, select them in the Users Assigned pane, then click the < arrow. 

The Roles settings in Jaspersoft.

Adding a new role in Jaspersoft.

16



5. Click Save.

6. In RiskVision, navigate to Administration > Users > Roles.

7. Create a role in RiskVision, ensuring a selection is made from the Jasper Role dropdown menu, and assigning permissions as required. See the
Create a New Role article for more information.

Assigning users to a role in Jaspersoft.
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8. From the new role's settings, click Assigned Users > Add, then select the same user(s) added to the Jaspersoft role in step 4 above. 

9. Click Information in the menu to the left. 

10. Click Configure UI to enable Configuration mode, then click OK to close the confirmation message.

The New Role window in RiskVision.

Adding a user to a role in RiskVision.
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11. Click the icon beside the Jasper Role field to open the Configure attribute window.

12. Click Edit Options.

The Information section of the role's settings.

The Jasper Role field in the Information settings of the role.
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13. Click Add an option.

14. Enter a label in the Label field and type the exact name of the Jaspersoft role created in step 3 above in the Value field.

15. Click OK to close attribute windows and save your changes.

16. Click Configure UI (active) in the top-right corner of the page to disable Configuration mode, then click OK to save your changes.

17. Navigate to Jaspersoft > View > Repository, ensuring you're still logged into Standalone.

18. Expand the RiskVision folders in the Folders tree to the left to display the folders you wish to apply role permissions on.

19. Right-click a folder, then select Permissions.

The Configure attribute window.

Adding the Jasper
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20. Apply permissions on the folder for the role created in step 3 above as needed. Note that RiskVision roles are automatically assigned the
ROLE_USER role in Jaspersoft and this role cannot be removed, but its settings may be overridden by following the instructions below:

To deny access to a folder, assign No Access permissions on the ROLE_USER role and the RiskVision role.

To provide read-only access to a folder, assign No Access permissions on ROLE_USER role and Read Only access the folder on the
RiskVision role.

The Repository settings in Jaspersoft where you can apply role-specific permissions to each folder.
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21. Click Apply to save your changes.

Permission settings for a folder.
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R6 Report License

Resolver is preserving R6 Reporting for long-time RiskVision customers who have legacy reports in R6 Reporting that they have not been able to
transition to RiskVision's JasperReports Server. As of Version 9.0, customers will need to request a license key with R6 Reporting enabled from
Resolver Support. 

The following table shows the differences in RiskVision’s behavior when the R6 license is enabled:

FEATURE WITH R6 LICENSE WITHOUT R6 LICENSE

Menus Available in the

Analytics Tab

Analytics and Reporting

R6 Dashboards and Reports

R6 Charts

R6 Report Templates

R6 Report Status 

Analytics and Reporting 

Configure UI

Permission
Required for creating an R6 Custom Query chart.

Required to view and create R6 charts. Only table-

type charts with custom queries can be created.

Enabled Properties

To create R6 Charts, enable
allowNewReport=true

To create R6 Dashboards and Reports,
enable allowNewDashboard=true

To create R6 table-type charts with custom
queries, enable allowNewReport=true

Viewing R6 Charts,

Dashboards, and

Reports

Users can access R6 Dashboards and Reports, R6

Report Templates, and R6 Report Status.

To view archived R6 Charts, enable
showArchivedReports=true

To view archived R6 Dashboards and
Reports, enable
showDashboardPage=true 

New Group and Export

Group Actions

Users can select New Group and Export Group

under My Charts and My Dashboards.

Users cannot execute New Group or Export

Group.

The Analytics tab with an R6 License.

The Analytics tab without an R6 License.
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Running a Chart

Running a chart combines a chart definition with the latest information. To run a chart, you will need the Dashboards and Reports View permission.

To run a chart:
1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts that the group contains.
Locate the desired chart in the list on the right, and check the box associated with the chart.

3. Click Run.
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Scheduling a Chart

Charts can be scheduled to run at regular intervals, starting at a specified day and time. In order to a schedule a chart, your user role must have the
Dashboards and Reports View permission. 

To run a chart at regular intervals: 

1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts that the group contains.
Locate the desired chart in the list on the right and check the box associated with the chart.

3. Select Schedule in the More Actions drop-down list. The Schedule dialog appears.

4. Enter the following parameters:

Parameter Description
Frequency Choose Daily, Weekly, Monthly, or Hourly.
Start Time Enter the time of day of when to run the chart.
Start Date Enter the date on which to run the first chart.
Select the Days of
the Week (Weekly)

Check the days on which to run the chart.

Select the days of
the month and the
months (Monthly) 

Select the day of the month: First, Last, Fifteenth, or enter a particular day, such as
the 10 . Check the months in which to run the chart.

Frequency in hours
(Hourly)

Enter the number of hours between runs of this chart.

Perform this task
(Daily)

Select how often the chart must be run. Choose Every Day, Weekdays, or
Weekends.

Email archived
report to current
user

Check to send the report to the currently logged-in user.

Password protect
archived report in
email

Check to protect the archived report with a password.
                 

5. Click OK.

6. Confirm that the chart has been scheduled by clicking Administration > Scheduled Jobs. To show only scheduled charts, filter by Job Group
and enter Charts.

th
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Editing a Chart

Depending on your privileges, you may edit or delete particular chart definitions. Editing and deleting a chart requires you to have the Dashboards
and Reports View and Dashboards and Report Author permissions.

To edit a chart definition:
1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts that the group contains.
Locate the desired chart in the list on the right, and check the box associated with the chart.

3. Click Edit.

4. Click on the tabs along the top — General Configuration, Chart Type, Column Selection, Configure Filters, Advanced Settings — to go
directly to the page to edit. Click Next and Previous to edit multiple pages.

5. Click Finish when the edits are complete.

To delete a chart definition:
1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts. Locate the desired chart
in the list on the right and check the box associated with the chart.

3. Click Delete.
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Archiving Charts

Running a chart with the latest information and saving the results is called archiving the chart. The dated chart will then be available in the system as
historical data. Your user role must have the Dashboards and Reports View permission in order to archive a chart.

To archive a chart:

1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts. Locate the desired chart in the
list on the right and check the box associated with the chart.

3. Select Archive from the pull-down list of More Actions.

4. Select the destination 'Archived charts folder.' Change the chart's name, if desired, and choose an output format:

PDF

HTML

PNG

CSV (table charts only)

If you have archived reports and dashboards in a version earlier than 7.5, those reports and dashboards will fail to open in version 7.5. To open the
archived reports in 7.5, move the files one level down to the %AGILIANCE_HOME\data\reports directory from the %AGILIANCE_HOME%\data
directory. To open the archived dashboards in 7.5, move the files one level down to the %AGILIANCE_HOME\data\dashboards directory from the
%AGILIANCE_HOME%\data directory.

27



Understanding The Chart Tree Structure

The chart tree structure, on the left side of the window, provides easy access to RiskVision charts available in various folders such as My Charts,
Shared Charts, and Archived Charts. The ability to view, run, create, delete, and perform other actions on charts depends on your roles and
permissions. You can create a new group under the Public group of Shared Charts if you have the Dashboards and Reports View permission.
However, adding and managing a group in other groups including the Public group requires you to have the Dashboards and Reports View and
Dashboards and Reports Author permissions.

You can create additional folders, but the chart tree includes the following folders by default:

My Charts. Contains the charts for which you are an owner.

Shared Charts
Public. Contains charts that can be accessed by all users.

System Charts. Contains predefined charts that you can use as-is or that you can copy to provide a basis for your own charts.

Archived charts
My Archived Charts. Contains the results of running charts for which you are an owner and charts that you have run.

Shared Archived Charts. Contains historical charts that can be viewed by any user.

For more information see Archiving Charts and Copying a Charts.
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Copying a Chart

To copy a chart, use the Export and Import functions. Export saves the chart definition locally in an XML file. Edit the XML file as desired (for example,
to change the chart name) and then import the XML file to create a new chart definition. To perform the export and import actions, your user role
must have the Dashboards and Reports View and Dashboards and Reports Author permissions. Note that system charts can be exported using the
Dashboards and Reports View permission.

To Copy a Chart:
1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts. Locate the desired chart
in the list on the right, and check the box associated with the chart.

3. Select Export in the More Actions drop-down list.

4. Save the chart to a local folder.

5. Edit the locally-saved XML file by using a text editor (such as Notepad) and change the chart name.

6. Choose the destination chart group and select Import in the More Actions drop-down list. Select the edited XML file and import the chart
definition.

Note for IE6 users

Because RiskVision uses secure communications between the browser and server (HTTPS), IE6 may report an error instead of downloading a PDF or
other format file. The error is:

Internet Explorer cannot download from .

To work around this IE6-specific behavior, uncheck the IE6 option "Do not save encrypted pages to disk." This issue is not a problem in other
browsers or other versions of Internet Explorer. For more information and a hotfix from Microsoft, see support.microsoft.com.
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Exporting Charts

Chart definitions can be saved locally in XML format. Charts that have been exported can be imported to create new chart definitions. See Copying a
Chart.

To export a chart definition:
1. On the Analytics menu, click R6 Charts.

2. Locate the chart group containing the desired chart in the tree on the left. Click the chart group to display the charts that the group contains.
Locate the desired chart in the list on the right and check the box associated with the chart.

3. Select Export in the More Actions drop-down list. Save the chart to a local folder.

Note for IE6 users

Because RiskVision uses secure communications between the browser and server (HTTPS), IE6 may report an error instead of downloading a PDF or
other format file. The error is:

Internet Explorer cannot download from .

To work around this IE6-specific behavior, uncheck the IE6 option "Do not save encrypted pages to disk." This issue is not a problem in other
browsers or other versions of Internet Explorer. For more information and a hotfix from Microsoft, see support.microsoft.com. 
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About Dashboards and Reports

A Dashboard displays a collection of charts, that is, data compiled from multiple points of interest in HTML, or saves the collection of reports with
information for a specific period to PDF or Excel format.

Charts only display information on objects to which the current user has access, such as the programs the current user owns.

Dashboards provide the following functionality:

Assign HTML Dashboards to display in the user's initial landing page, schedule the interval when the report data is updated, and publish the
dashboard to other Portals, such as Salesforce and Sharepoint. Publishing the HTML dashboard allows others to see data and statistics for
programs as well as entities as they are being evaluated. You can also run and display the dashboard from the Dashboard folder.

Archive a dashboard to PDF, HTML, or PNG format. Saving the dashboard allows you to create a snapshot of information during a specific
period. You can save PDF, HTML, or PNG versions locally or you can archive them in the RiskVision solution and point to the archived file from
other portals.

Export results to Excel.

The RiskVision solution provides a wide variety of system dashboards that are used for landing pages such as the Program Summary dashboard that
displays on the R6 Charts tab of Program details page.
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Chart Status

The Chart Status page displays information about charts in progress.

To cancel a chart, select it in the grid, and click Cancel.
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About Report Templates

Report templates provide a base for new dashboards. The RiskVision application provides the following default templates:

Template Name Description

Multiple Program - Entity
Regulation Compliance
Indicator

Shows the Indicator of the compliance level of this entity with respect to the regulation. This is applicable to the
entities that have been tagged as applicable to that regulation. Only the key risks that have been tagged for this
regulation are considered.

Multiple Program - Key
Risk Regulation
Compliance Indicator

Shows the Indicator of the compliance level of this key risk with respect to the regulation. This is applicable to the
key risks that have been tagged as applicable to that regulation. Only the entities that have been tagged for this
regulation are considered.

Multiple Program - Key
Risks Entity Summary

Shows the trend of key risk results for all the entities in multiple programs. Any entities assigned via dynamic
groups are also included.

Multiple Program - Key
Risks Summary

Shows the trend of key risk results for the dynamic groups and entities in multiple programs. This is useful to drill-
down on dynamic groups that are modeled to reflect organization hierarchies.

Policy Document -
ControlObjective Renders a Control Objective as a policy document.

Policy Document -
ControlPolicy Renders a Control Policy as a Policy document.

Policy Document - Group Renders a Group of Policies as a Policy document.

Policy Document - Section Renders a Group of Policies as a Policy document.

Single Program - Dynamic
Group Key Risks
Summary

For a given Key Risk Indicator and dynamic group pair, this dashboard shows the trend of key risk results for all the
dynamic groups at the next level. This is useful to drill-down on dynamic groups that are modeled to reflect
organization hierarchies.

Single Program - Entity
Key Risk Indicator Value
Trend

For a given Key Risk Indicator and entity pair, this dashboard shows the history of the values that have been
entered.

Single Program - Entity
Key Risk Summary For a given Key Risk and entity pair, this dashboard shows the trend of key risk indicator results.

Single Program - Entity
Regulation Compliance
Indicator

Shows the Indicator of the compliance level of this entity with respect to the regulation. This is applicable to the
entities that have been tagged as applicable to that regulation. Only the key risks that have been tagged for this
regulation are considered.
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Single Program - Key Risk
Regulation Compliance
Indicator

Shows the Indicator of the compliance level of this key risk with respect to the regulation. This is applicable to the
key risks that have been tagged as applicable to that regulation. Only the entities that have been tagged for this
regulation are considered.

Single Program - Key
Risks Entity Summary

Shows the trend of key risk results for all the entities in the program. Any entities assigned via dynamic groups are
also included.

Single Program - Key
Risks Summary

Shows the trend of key risk results for the dynamic groups and entities in the program. This is useful to drill-down
on dynamic groups that are modeled to reflect organization hierarchies.

Template Name Description
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About Dashboard Folders

Dashboard folders control access, as follows:

My Dashboard. Current user can read, write, and modify dashboards in this folder.

 Shared Dashboards.

 System. System Administrators can read, write and modify content. Typically contains Resolver provided content that only the
system user can read and copy.

 Public. Any system user can read, write, and modify dashboards in this folder.

 Archived Dashboards. Contains a PDF formatted file of a dashboard. PDF copies provide a snapshot for a particular time and date.

 My Archived Dashboards. Contains a PDF formatted files of a dashboard the only the current user can access.

 Shared Archived Dashboards. Contains PDF formatted files of a dashboard that only all the system users can access.
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Configuring Column Dashboards

This section explains how to add and configure analytical data into easy-to-read dashboards for reporting purposes. Dashboards within the
RiskVision solution can be configured to have multiple columns to display different kinds of charts and data. Dashboards are a good way to showcase
existing charts to help summarize information such as the current state of compliance for an organization. With the RiskVision solution, it is easy to
lay out the dashboards and make changes to the layout as needed. You can edit a dashboard and add or remove a chart from the dashboard using the
Dashboards and Reports View and Dashboards and Reports Author permissions.
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Adding Charts

A dashboard can contain any RiskVision solution chart. The chart must be defined before you can add it to a dashboard. However, each dashboard
can run the chart with different parameters.

To add a chart:
1. Go to Analytics > Dashboards and Reports.

2. Locate the dashboard to which you want to add a chart, and open the details.
Expand the Dashboard groups in the navigation pane.

Select the group to display a list of dashboards.

Select the dashboard, and click Details.

If chart data is available, the chart runs and displays the results on the Dashboard Details page.

3. Click Add Content. The Select one or more Charts dialog appears.
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4. Locate and select the charts you want to add.

5. Click OK.

The chart displays on the dashboard details page with the chart results if data is available and no parameters are required. Otherwise, the chart
displays with a parameter error.
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Setting The Chart Parameters

The chart parameters determine which objects, such as programs and entities, to run the dashboard chart against. The parameters apply to the
dashboard only. You can either set all charts to use the same parameters or set the parameters for each chart.

To set up parameters:
1. Go to Analytics> Dashboards and Reports.

2. Locate the dashboard to which you want to add a chart, and open the details.
Expand the Dashboard groups in the navigation pane.

Select the group to display a list of dashboards.

Select the dashboard, and click Details.

If chart data is available, the chart runs and displays the results on the dashboard details page.

3. Click Parameters. The Select a Parameter Configuration dialog appears.

4. Expand Configure Parameters, and select one of the following options:

 Dashboard Parameters. To set similar parameters for all charts.

Chart Parameters > report name. To set different parameters for each chart.

5. Click OK. The Edit Report Parameters or Edit Dashboard Parameters dialog appears.

39



6. Select a program, select entity, and then click OK.

The dashboard displays the report results using the parameters that you have set.
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Removing Charts From Dashboards

You can remove all charts from a dashboard. Clearing the charts creates a blank dashboard.

To clear charts:
1. Go to Analytics > Dashboards and Reports.

2. Locate the dashboard to which you want to add a chart, and open the details.
Expand the Dashboard groups in the navigation pane.

Select the group to display a list of dashboards.

Select the dashboard, and click Details.

If chart data is available, the chart runs and displays the results on the dashboard details page.

3. Click Clear. The dashboard displays blank.
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Defining Reports with Excel Templates

The RiskVision solution supports simple column-based dashboards and HTML/Velocity template-based reports. You can also define custom reports.

Excel report templates created outside of RiskVision can be used as a report template. Additionally, RiskVision supports the creation of excel report
templates to allow viewing and printing reports directly within Excel (or Excel Viewer).

The Excel-based custom report facility is designed to cleanly separate data presentation from data generation and to allow users to use the existing
user interface for other types of reports.

An Excel-based report template is a normal Excel workbook or template. As such, all Excel features can be used, including macros and VB scripts.
Currently, only Excel 97-2003 is supported. Typically, an Excel report template has one sheet with the charts and tables for the final report.

Note that tables, individual rows, columns, and cells in the report can be populated directly without using another data sheet. Also, data sheets can be
hidden through Excel scroll-locking.

Depending on the complexity of the report, the template must have either a Properties sheet or a Velocity script.

Simple Template with a Properties sheet

Allow independent reports only

Allow single-valued parameters

Allow fixed data destinations

Advanced Template with a Velocity Script

Allow reports that depend on the results of other reports

Allow calls to Java methods to get data for charts and tables

Allow list-valued parameters

Allow relative data destinations

Allow control-flow structures (e.g., if-then-else and for each loop)

For more information, see Creating a simple report template or Creating an advanced report template.
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Creating a Simple Report Template in Excel

For simple report-only dashboards, using a simple Properties worksheet in Excel is sufficient to provide all the necessary information for parameters,
reports, and their data destinations.

Normally, such a Properties worksheet contains two sections, one for all parameters and one for reports.

Specifying Report Parameters

In the first section of the Properties worksheet, list the report parameters. For each parameter that you want the system to prompt for a value at
runtime, you can specify the name, the label, the data type, and where the value must be placed in the dashboard.

The only mandatory property is the name, and it must be set first. All other properties are optional. If the label property is not specified, the name will
be used as the default label. The valid data types are listed below and the default data type is String. 

By default, the value of the parameter will not be shown in the dashboard.

String

Number

Date

Timestamp

Entity

Control

 Subcontrol

Program

Vulnerability

Ticket

 DynamicGroup

Here is an example for date type parameter:

parameter1.name = reportDate 

 parameter1.label = Report Date 

 parameter1.type = Date 

 parameter1.value.target = Dashboard!$D$2

Specifying Reports

In the second section of the Properties worksheet, list the reports. For each report, specify the fully-qualified name and the data destination.

The data destinations are specified in the Excel format as follows:

1. A single cell:

 SheetName!$ColumnName$RowNumber

2. A single row:

 SheetName!$StartColumnName$RowNumber:$EndColumnName$RowNumber

3. A single unbounded column:

SheetName!$ColumnName
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4. A single bounded column:

 SheetName!$ColumnName$StartRowNumber:$ColumnName$EndRowNumber

5. An unbounded range:

SheetName!$StartColumnName:$EndColumnName

6. A bounded range:

SheetName!$StartColumnName$StartRowNumber:$EndColumnName$EndRowNumber
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Report Examples

report1.name = /My Reports/Entity Distribution by Criticality

 report1.target = DataSheet1!$A$1:$B$6

 report2.name = /My Reports/Entities with Lowest 10 Compliance Scores

report2.target = Dashboard!$B$31:$E$40

 report3.name = /My Reports/Entities with High Criticality

 report3.target = DataSheet2!$A:$G

In the first example above (report1), the summary report will populate a bounded range in DataSheet1 that will be used to generate a pie chart or bar
chart in the dashboard. Note that the first row of a data sheet is reserved for column headers and the actual data will start with the second row. In
addition, eventhough normally there will be only 5 or 6 possible values for entity criticality, it is not necessary to use a bounded range.

In the second example above (report2), the 10-row table in the dashboard would be populated by the report directly. Note that the range does not
include the row for the column headers because it does not start with the first row.

In the third example above (report3), the report will put data into an unbounded range in DataSheet2. The dashboard creator does not know how
many entities have high criticality. You do not want to limit the number of entities shown. In this case, the dashboard creator could create a viewport
(a table with a fixed size) in the dashboard and use a VBScript to page through the data in DataSheet2 interactively.
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Understanding HTML Report Templates

To help explain custom HTML report templates, this topic introduces several examples of increasing sophistication that show how to utilize the
Velocity template language in custom HTML code to produce custom RiskVision reports.

Example 1 explains the basics of creating a custom HTML report template and leads to the subsequent examples, which build on each other.

Overview

Users with sufficient privileges can create and modify HTML report templates. HTML reports can pull data from the RiskVision database in the form
of data fields, tables, and charts. This is accomplished using embedded Velocity variables and language constructs. An HTML report template is a
canonical HTML document with optional Velocity statements before, after, and embedded within the HTML. The HTML markup can be as advanced
as XHTML strict or as simple as "quirks mode."

RiskVision limits the size of any HTML template to a fixed maximum, placing a limit on the amount of HTML text that can be entered. Velocity
constructs such as loops can be more concise than plain HTML.

Report templates can be used with different data. Because understanding a set of charts takes time, the best practice to use the similar report for
related data to facilitate consistency and comparability. A compliance report, for example, might be used for both Sarbanes-Oxley and PCI.

Chart attributes and the objects being reported on are both "parameters" for the report. System reports prompt for parameters every time the report
is run, but user-defined reports remember their parameters and do not prompt after the first run. The Parameters links supports changing the
parameters after the first run of a custom HTML report.

Report output can be exported as an HTML and loaded into an application such as Microsoft Word in order to produce an even-more polished report
(with a cover page, headers and footers, and an index, perhaps).

See also

Report Template Variables

Reporting on RiskVision Objects
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Configuring Report Templates

Resolver recommends basing your template on an existing template. Visit the Agiliance Customer Support portal for additional templates and details
on template variables.
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Creating A New Template

Create a new template for users to customize when setting up their own dashboards. Your user role must have the Report Template View and
Report Template Manage permissions so that you can create, modify, or delete a report template.

To create a new template:

1. Go to Analytics > Report Templates.

2. Click New. A blank dashboard displays below the report template table.

3. Enter the general information:

 Name. Enter the display name that users select in the new dashboard dialog.

 Description. Enter a summary that describes the template.

4. Enter the content. You must use valid HTML and include the DTD and required dashboard parameters.

5. Click Save.

The template is now available from the new dashboard dialog.

48



Modifying A Template

To modify a template:

1. Go to Analytics > ReportTemplates.

2. Select the template, and click Details.

3. Click Edit.

4. Modify the general information and content.

5. Click Save.

The template is updated. The modified version is used to create new dashboards.
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Creating Reports for Affected Entity Groups

When a user upgrades from a version of RiskVision below 9.0 to 9.0 or above, any custom groups will be deleted. In addition, the custom groups will
not appear in a vulnerability's Affected Entities tab even after being created. In order to properly display a custom group, two R6 reports must be
created for each new group: one for summary details, and one for drill down reports.

R 6  r e p o r t s  s h o u l d  o n l y  b e  c r e a t e d  b y  a  S y s t e m  A d m i n i s t r a t o r .  T h e y  c a n  b e  v i e w e d  b y
a n y o n e  w i t h  C o n ' g u r e  U I  p e r m i s s i o n s .

Before You Begin

Before the R6 reports can be created, the user must be granted R6 permission.

T h i s  o n l y  n e e d s  t o  b e  d o n e  o n c e .  Yo u  c a n  s k i p  t h e s e  s t e p s  i f  y o u ' v e  a l r e a d y  b e e n  g r a n t e d
R 6  p e r m i s s i o n .

To grant R6 permission:

1. Navigate to and open the agiliance.properties file.

2. Set the following properties:

allowNewReport=true

com.agiliance.dal.model.FusionReport.showHiddenReports=true

com.agiliance.dal.model.ObjectGroup.showHiddenGroups=true

com.agiliance.report.logReportQuery=true

3. Restart the Tomcat service.

Report 1

To create the summary details report: 

1. In the RiskVision Threat and Vulnerability Manager application, navigate to Analytics > R6 Charts.

2. In the pane to the left, open the Shared Charts > System Charts > Vulnerability folder. 

3. Click New. The Create a Chart dialog appears.

The Vulnerability folder of the R6 charts tab.
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4. Click the Use Custom SQL Query checkbox.

5. Enter the name of the relevant custom group in the Name and Display Name fields.

6. Enter the following query in the Custom SQL Query field:

T h e  q u e r y  y o u  e n t e r  i n t o  t h i s  ' e l d  m u s t  c o n t a i n  t h e  r e l e v a n t  c u s t o m  g r o u p ' s  n a m e
a n d  a t t r i b u t e s .  T h e  f o l l o w i n g  q u e r y  i s  a n  e x a m p l e  m a d e  f o r  a  g r o u p  n a m e d  A P P G R
t h a t  c o n t a i n s  t h e  A p p P r o d u c t ,  A p p Ve n d o r ,  A p p Ve r s i o n ,  a s s e t _ s u b t y p e ,  a s s e t _ t y p e ,
a n d  o w n e r _ n a m e  a t t r i b u t e s .  R e p l a c e  t h e s e  e l e m e n t s  a s  n e c e s s a r y  w h e n  w r i t i n g  y o u r
o w n  q u e r y .

SELECT t.APPGR_ID AS GROUP_ID,

t.vulnerability_id,

t.AppProduct,

t.AppVendor,

t.AppVersion,

t.criticality,

t.owner_name AS OWNER,

MAX(t.risk_score) AS risk,

COUNT(DISTINCT t.asset_id) affected_assets,

COUNT(DISTINCT CASE WHEN t.scanner_reported = 1 THEN t.asset_id ELSE NULL END) scanner_reported,

The Create a Chart dialog.
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COUNT(DISTINCT CASE WHEN t.ticket_count = 0 THEN t.asset_id ELSE NULL END) AS without_tickets,

COUNT(DISTINCT CASE WHEN t.ticket_count = 0 AND t.exception_count = 0 THEN t.asset_id ELSE NULL END)
without_ticket_exception,

COUNT(DISTINCT CASE WHEN t.patch_count > 0 THEN t.asset_ID ELSE NULL END) patch_count

FROM agl_agrp_appgr_dtl t

where t.vulnerability_id = %CV_VULNERABILITY_ID%

GROUP BY t.APPGR_ID, t.vulnerability_id,t.AppProduct,t.AppVendor,t.AppVersion,t.criticality,t.owner_name

7. Click Next.

8. Select the Table chart type.

9. Click the Suppress Duplicate Rows checkbox.

10. Click Next.

11. Move all columns to the Selected Columns list, ensuring the GROUP_ID column is at the top of the list.

The Chart Type tab of the Create a Chart dialog.
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12. For each selected column, change the value of the Header field to be more user friendly. For example, change affected_assets to Affected
Assets.

13. Click Next.

14. Click Next in the Filters tab.

15. Click Next in the Advanced Settings tab.

16. For each of the following drill down columns, select Detail in the Drill Down To field and select GROUP_ID from the dropdown list:

affected_assests

scanner_reported

without_ticket

without_ticket_exception

patch_count

The Column Selection tab of the Create a Chart dialog.
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17. Click Finish.

Report 2

To create the drill down report: 

1. In the RiskVision Threat and Vulnerability Manager application, navigate to Analytics > R6 Charts.

2. In the pane to the left, open the Shared Charts > System Charts > Vulnerability folder.

3. Click New. The Create a Chart dialog appears.

The Drill Down tab of the Create a Chart dialog.

The Vulnerability folder of the R6 charts tab.
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4. Click the Use Custom SQL Query checkbox.

5. Enter the name of the custom group followed by "_detail" (e.g. APPGR_detail) in the Name and Display Name fields.

6. Enter the following query in the Custom SQL Query field:

T h e  f o l l o w i n g  q u e r y  c a n  b e  u s e d  d i r e c t l y  b y  c h a n g i n g  t h e  t a b l e  n a m e  ( e . g .
a g l _ a g r p _ a p p g r _ d )  t o  m a t c h  t h e  g r o u p  n a m e .

SELECT DISTINCT t.asset_id AS ASSET_ID,

a.asset_type AS ICON,

a.name AS NAME,

a.asset_type AS ASSETTYPE,

a.asset_subtype AS ASSETSUBTYPE,

t.criticality AS CRITICALITY,

t.owner_name AS OWNERNAME,

a.description AS DESCRIPTION,

t.ticket_count AS ticket,

t.patch_status AS patchstatus,

t.resolve_status AS resolvestatus,

The Create a Chart dialog.
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t.Appgr_ID,

t.ticket_count,

t.exception_count,

t.patch_count,

t.scanner_reported,

t.asset_to_vulnerability_id

FROM agl_agrp_appgr_dtl t

INNER JOIN agl_asset a ON a.asset_id = t.asset_id

where t.Appgr_ID IN (%CV_GROUP_ID%)

7. Click Next.

8. Select the Table chart type.

9. Click the Suppress Duplicate Rows checkbox.

10. Click Next.

11. Move the following columns from the Custom Query folder to the Selected Columns list and ensure that they are in the following order: 

I f  a n y  o f  t h e  b e l o w  c o l u m n s  a r e  n o t  a v a i l a b l e ,  t h e y  c a n  b e  i g n o r e d  a s  l o n g  a s  t h e
g e n e r a l  s e q u e n c e  o f  t h e  l i s t  i s  a d h e r e d  t o .

ASSET_ID

The Chart Type tab of the Create a Chart dialog.
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ICON

NAME

ASSETTYPE

ASSETSUBTYPE

ticket

OWNERNAME

CRITICALITY

DESCRIPTION

patchstatus

resolvestatus

asset_to_vulnerability_id

12. For each selected column, change the value of the Header field to be more user friendly. For example, change ASSETTYPE to Asset Type.

13. Click Next.

14. Click Next in the Filters tab.

15. Create the following conditions and click the Use this condition as a parameter to a chart checkbox. 

Custom Query.ticket_count equals 0

Custom Query.exception_count equals 0

Custom Query.patch_count greater than 0

Custom Query.scanner_reported greater than 0 

The Column Selection tab of the Create a Chart dialog.
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16. Click Next.

17. For each of the following drill down columns, select Detail in the Drill Down To field and select the listed option from the dropdown list:

Name: Asset_ID

resolvestatus: asset_to_vulnerability_id

18. For each of the above drill down columns, enter General  in the Tab Name field.

The Advanced Settings tab of the Create a Chart dialog.
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19. Click Finish. 

20. Logout of RiskVision and log back in.

21. In the Threat and Vulnerability Manager application, navigate to the Affected Assets tab of any vulnerability.

22. Select the freshly created group.

The Drill Down tab of the Create a Chart dialog.
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Enable Total Risk Scores of Custom Groups

Custom groups of vulnerabilities will have their own Vulnerability Risk Score. If you have created any custom groups, you will need to follow the
below steps to properly display the group's aggregated vulnerability risk scores in the Affected Entities tab:

I n  o r d e r  t o  c o m p l e t e  t h e  b e l o w  s t e p s ,  t h e  u s e r  m u s t  ! r s t  h a v e  t h e  R 6  R e p o r t  L i c e n s e
e n a b l e d .

To display a custom group's total risk score:

1. Navigate to and open the %AGILIANCE_HOME%\config\agiliance.properties file.

2. Enable the below properties:

allowNewReport=true

com.agiliance.dal.model.FusionReport.showHiddenReports=true

com.agiliance.dal.model.ObjectGroup.showHiddenGroups=true

com.agiliance.report.logReportQuery=true

3. Log into RiskVision as a Sysadmin.

4. In the Threat & Vulnerability Manager application, navigate to Analytics > R6 Charts.

5. Click the Vulnerability folder in the navigation tree to the left.

6. Click the custom group that is not displaying the total risk score.

7. Navigate to the General tab and click Edit.

The Vulnerability folder of the R6 Charts section.

A custom group's Details page.
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8. In the Custom SQL Query field, change the MAX(t.risk_score) query to read ROUND(SUM(t.risk_score),2).

9. Click Finish.

The Editing Chart dialogue.
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Report Template Variables

Report templates are HTML files with Velocity template language (VTL) statements embedded. Velocity statements look like #set( $var = value ), or
#if ( $var >= 34 ). Velocity falls under the Apache organization. For more information, visit velocity.apache.org.

The Velocity template language provides access to key RiskVision solution objects, including those described below. For examples of Dashboard
Templates, see Creating an Advanced Report Template.

$dashboardContext

void

bindSavedParameterValues()

Dashboard

getDashboard()

DashboardParameters

getDashboardParameters()

void

initReports(

List report URIs)

A dashboard template must call initReports if the dashboard has dependent reports.

void

loadObject(

String className)

boolean

isPreprocessing()

boolean

isRendering() – true if not preprocessing

void

saveParameters()

void

setDashboardParameters(

Map

String> parms,

Map

String> reportParms)

void

setParameter(

String key,

[ String logicalReportId, - optional
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String pname ] - optional

Object val)

void

setPreprocessing(

boolean value)

void

setRendering(

boolean value)

$dashboardParameters

void

addDashboardReport(

String URL,

FusionReport report,

DashboardContext context)

DashboardParameterInstance

addParameter(

String name,

String label

[ String type ] - optional

[ boolean isList ] - optional

[ String filter ] - optional

)

Types are: String, Number, Date, Timestamp, Entity, Control, Subcontrol, Program, Vulnerability, Ticket, or DynamicGroup.

Entity

getEntity(

String key,

String displayName)

List

getEntities(

String key,

String displayName)

PolicySet

getControl(

String key,

String displayName)
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List

getControls(

String key,

String displayName)

DashboardReport

getDashboardReport(

String URL)

Date

getDate(

String key,

String displayName)

String

getDateStr(

String key,

String displayName)

VirtualGroupInstance

getDynamicGroup(

String key,

String displayName)

List

getDynamicGroups(

String key,

String displayName)

Object

getParameterValue(

String name)

AuditProject

getProject(

String key,

String displayName

[, filter] - optional

)

List

getProjects(

String key,
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String displayName

[, filter] - optional

)

DashboardReport

getReport(

String id)

String

getReport(

String URL,

String size

[, String logicalReportId] - optional

)

String

getReportLookupKey(

String URL,

String logicalReportId)

DashboardReport

getReportByUrlandLogicalReportId(

String URL,

String logicalReportId)

Policy

getSubcontrol(

String key,

String displayName)

List

getSubcontrols(

String key,

String displayName)

Ticket

getTicket(

String key,

String displayName)

List

getTickets(

String key,
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String displayName)

String

getTimestamp(

String key,

String displayName)

Vulnerability

getVulnerability(

String key,

String displayName)

List

getVulnerabilities(

String key,

String displayName)

void

setControl(

String URL,

String key,

[String logicalReportId,] - optional

PolicySet value)

void

setVulnerability(

String URL,

String key,

[String logicalReportId,] - optional

Vulnerability value)

$dashboardProcessor

String

getAbortOnFirstReportError()

DashboardContext

getDashboardContext()

int

getMaxRows()

FusionReport

getReport(

String reportURI)
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List>

getReportData(

String reportURI,

Map

String> parms,

Integer maxRows)

void

setMaxRows(

int max)

void

setAbortOnFirstReportError(

String actionOnReportError)

Other Objects

Other system objects can be requested using the dashboard methods described here, including:

Entity (that is, entity)

AuditProject (that is, assessment program)

DashboardReport

Object

Policy

PolicySet

Ticket

VirtualGroupInstance (that is, dynamic group)

Vulnerability

These objects typically have a.getTitle() method and a.getDescription() method which provide sufficient information about the object for dashboard
purposes.
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Reporting On Riskvision Objects

The chart wizard can be used to report on various objects. The RiskVision solution ships with a number of reportable objects. These objects are
shown in the Chart drop-down list, available on the General wizard page of the Create a Chart wizard.

You can define additional custom objects and add them to the list of reportable objects. The new custom objects will show up in the Chart ondrop-
down list to be used to create new reports.

The chart wizard is driven by a set of configuration files, including:

ReportViews.xml

ReportSummaryTables.xml

ReportAttributes.xml

ReportJoinConditions.xml

ReportWizardOptions.xml

The default versions of these files are deployed in the web deployment folder under WEB-INF\classes . Do not modify these files because they
are replaced every time a new version of the software is installed. To add customizations, create files with the same name in the
%AGILIANCE_HOME%\config  directory. Once the customizations are deployed, there are two ways for the server to pick the customizations.

Oneway is if you stop and start the server customization files will be reloaded . The other way is to go to the "Administration" area, choose the
"Commands" tab, and click the Reload button in the configuration section.
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Now, let us review each of the configuration files.

ReportViews.xml

All reportable objects that are built as database views are defined in this file. In this file, users can define a view name, define a display name, provide
a detailed description, and an SQL query to build the view. For example, if the users want to report on archived assessments, they could create a view
by using the SQL:

SELECT a.entity_id,

 a.name ,

 a.organization ,

 rap.compliance_score,

 rap.risk_score ,

 rap.end_date

FROM agl_entity a

 INNER JOIN agl_raproject rap

 ON rap.entity_id = a.entity_id

WHERE rap.archived =1;

Now that you have the SQL, you can make an entry in ReportViews.xml. If this is the only view in the customized ReportViews.xml, the content will
look like this.
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This view is used for creating reports on archived assessments.

]]>

 

 

SELECT a.entity_id,

 a.name ,

 a.organization ,

 rap.compliance_score,

 rap.risk_score ,

 rap.end_date

FROM agl_entity a

 INNER JOIN agl_raproject rap

 ON rap.entity_id = a.entity_id

WHERE rap.archived =1

]]>

 

 

70



ReportSummaryTables.xml

All reportable objects that are built as summary tables in the database are defined in this file. In this file, you can define a summary table name, define
a display name, give a detailed description, specify the SQL query that is used to build the summary table, and define indexes on the summary table.

Summary tables are similar to views but with important differences:

The data retrieved using views is the latest data in the database. The summary table, therefore, is current when it is built, but does not reflect
changes made since that time. The summary tables in RiskVision are updated by a scheduled job named “Report Summary Builder”. By
default, this scheduled job runs once a day.

The reports that are based on summary tables run faster than the reports based on views.

If you want to build a summary table with the SQL that is the same as the one used to build the view in the previous example, the content will look
like this (assuming there is only one summary table in the file):

 < Description >

  

This summary table is used for creating reports on archived assessments.

  ]]>

 

  

 

SELECT a.entity_id,

 a.name ,

 a.organization ,

  rap.compliance_score,

  rap.risk_score ,

 rap.end_date

FROM agl_entity a

 INNER JOIN agl_raproject rap

  ON rap.entity_id = a.entity_id

WHERE rap.archived =1

  ]]>

  

  

 

  CREATE INDEX aglx_archived_assessments_name on agls_archived_assessments (name)
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ReportAttributes.xml

This configuration file contains a list of all the attributes of objects that are available for reporting. When a new reportable object (view or summary
table) is created, the reportable attributes of that object have to be listed in this file. Continuing with the previous example, the view or summary
tables expose six columns. They are entity_id, name, organization, compliance_score, risk_score  and end_date . If
ReportAttributes.xml  will look like this (assuming that these are the only attributes defined):

 

 

 

 

 

Note that you have defined a group of attributes that correspond to the columns in the newly-defined reportable object. This group of attributes can
be referred later by the group name.
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ReportJoinConditions.xml

Once you have created a reportable object (view or summary table) and listed the attributes in ReportAttributes.xml, you are ready to report on the
object. But in most reports, you will want to include additional attributes in addition to the attributes of the newly-created reportable object. This
means that you need to define a way to associate other objects with this newly-created reportable object. In SQL terminology, you need to define join
conditions. In the reportable object that you created in the previous examples, you might have noticed that you also had an entity_idcolumn that you
did not add to the ReportAttributes.xmlfile. Use this column to connect the new reportable object with the entity object. If you assume that this is the
only join defined in ReportAttributes.xmlfile, the content would look like this.

 

 INNER JOIN agl_entity %2% ON %2%.entity_id = %1%.entity_id

In the xml, you have defined a new join condition that can connect the newly created reportable object with to the agl_entity table. The join condition
is identified by a key which is made up of the table names in lower case and separated by a comma. Please note that there is a single space after the
comma. The actual join condition is a SQL like join clause with variables that are replaced at run time with the actual table aliases. The following is a
list of columns that are most commonly used to connect to other tables.

Column Name Table/Object Name Table Name Report Attributes Group Name

entity_id Entity/Entity Table agl_entity Entity

raproject_id Assessment agl_raproject RAProject

auditproject_id Assessment Program agl_auditproject AuditProject

policyset_id
Controls, Policies, Questionnaires,

etc.
agl_policyset PolicySet

vulnerability_id Vulnerabilities agl_vulnerability Vulnerability

74



ReportWizardOptions.xml

You have defined a new reportable object, attributes of that object, and how you can connect this object with other objects. You are now ready to use it
in the report wizard.

Let’s say that you want to configure the wizard so that when the user reports on “Entities” and focuses on “Archived Assessments,” they can use the
newly-created reportable object. Assuming that only these customizations are in the ReportWizardOptions.xml , the file content would look like
this:

 

 

 

 

 

 

 

 

 

 

From the above example, you can see that you have defined a report on "Entity" and report focus "ArchivedAssessments" (notice that the display
names shown in the user interface are different). For a combination of "report on" and "report focus," you have defined the report attributes from
groups "Entity" (available by default) and "ArchivedAssessment" (defined by ), based on the newly-created reportable object. Users can choose
attributes from either group. Since you have defined the join condition between agl_entity  and aglv_archived_assessments , the server
can use that information to create an SQL query joining the two tables and return columns from both the tables.

The report on "Entity" is already defined in the default ReportWizardOptions.xml , so it does not need to be defined here. The content of the
custom ReportWizardOptions.xml  could be:

 

 

 

 

 

 

 

Note that ReportOnMapping has been removed.

The new options will show up in the chart wizard after you have put this together, deploy the files in the %AGILIANCE_HOME%\config  directory,
and restart the server.

75



In the available attributes area, you can see the attributes defined under the Archived Assessment section. You can also see a lot of other attributes.
This is because you included the Entity group in the Report Options section of ReportWizardOptions.xml .
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While building the ad-hoc filters in the advanced settings step, you can use all of these columns to build the filters.

77



Creating an Advanced Report Template

Velocity is a popular Java-based template engine. For a general introduction to the Velocity template language, see Apache.org.

If a dashboard needs to run reports based on the results of another report or needs to get data from Java objects, the Excel template must provide a
Velocity script instead of a simple Properties worksheet described in the previous section.

The Velocity script for an Excel dashboard template normally consists of three sections:

Section 1. Global Definitions

Define the URIs for dependent reports

Section 2. Preprocessing

Add the required dashboard parameters

Initialize the dependent reports

Section 3. Rendering

Get parameter value(s)

Define the target range/row/column/cell

Get data from reports

Get data Java objects

Populate the target range/row/column/cell

Return the content of the resulting dashboard (Excel workbook)
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Global Definitions

Section 1 describes global definitions. It is a good practice to define some global variables in this section to contain the URIs of the dependent
reports. Here are some examples:

 #set( $report1 = '/My Reports/Entity Distribution by Criticality')

 #set( $report2 = '/My Reports/Entities with Lowest 10 Compliance Scores')

#set( $report3 = '/My Reports/Entities with High Criticality')
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Preprocessing

Section 2 includes required dashboard parameters and other preprocessing actions. This section is enclosed inside the following if-end or if-else
block:

 #if ( $dashboardContext.isPreprocessing() ) 

#end

In this section, you can add required dashboard parameters (if any) and initialize the dependent reports.

While creating an Excel-based dashboard in the Console, the server will process the preprocessing section in the VelocityScript sheet of the Excel
template. More specifically, it will validate the report URIs, establish the dependencies between the dashboard and the dependent reports, and build
the report parameter map.

Here is an example:

#if ( $dashboardContext.isPreprocessing() )

 ##

 ## Add the required dashboard parameters.

 ##

 $dashboardParameters.addParameter('reportDate', 'Report Date', 'Date'))

 $dashboardParameters.addParameter('contentPack', 'Content Pack', 'Control')

 ##

 ## Must make this call to establish the relationships between the

 ## dashboard and the dependent reports and build the parameter map.

 ##

 $dashboardContext.initReports([$report1, $report2, $report3])

#end

Note that the method $dashboardParameters.addParameter() takes three parameters: name, label, and type. The valid data types are listed below:

 String 

 Number 

 Date 

 Timestamp 

 Entity 

 Control 

  Subcontrol 

 Program 

 Vulnerability 

 Ticket 

  DynamicGroup 

If the dashboard has any dependent reports, it is mandatory to call the method $dashboardContext.initReports().
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Rendering

Section 3 describes the rendering code. This section is enclosed inside the following if-end block:

#if ( $dashboardContext.isRendering() )

#end

Note that $dashboardContext.isRendering() is always the opposite of $dashboardContext.isPreprocessing(). If the script has a preprocessing section,
the end of the preprocessing section "#end" and the start of the rendering section "#if ( $dashboardContext.isRendering() )" can be replaced simply
by "#else."
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Getting Parameter Values

For complex dashboards, you often need to get the values of the parameters and use the values to control the data generation. To get the value for a
parameter, call the method $dashboardParameters.getParameterValue() with the parameter name that you specified in the preprocessing section.

For example, you can use the following line to get the content pack the user selected at runtime and assign the returned value to the variable
$contentPack:

#set( $contentPack = $dashboardParameters.getParameterValue('contentPack'))

Note that the variable name does not have to match the parameter name. Also, you may directly pass the returned values to other methods shown
below.
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Defining The Target Range, Row, Column, Or Cell

Normally, you would want to define the data destinations first and then use the assigned variables in other method calls. The dashboard processor
(i.e., $dashboardProcessor) provides the following methods for defining a target cell, row, column, and range:

1. A single cell:

getCell($excelCellReference)

getCell($sheetName, $columnName, $rowNumber)

2. A single row:

  getRow($excelRowReference) 

  getRow($sheetName, $startColumnName, $endColumnName, $rowNumber) 

3. A single unbounded column:

  getColumn($excelColumnReference) 

 getColumn($sheetName, $columnName) 

4. A single bounded column:

 getColumn($excelColumnReference) 

  getColumn($sheetName, $columnName, $startRowNumber, $endRowNumber) 

5. An unbounded range:

  getRange($excelRangeReference) 

 getRange($sheetName, $startColumnName, $endColumnName) 

6. A bounded range:

 getRange($excelRangeReference) 

 getRange($sheetName, $startColumnName, $startRowNumber, $endColumnName, $endRowNumber) 

You can use any valid Excel cell/row/column/range reference as a single argument or, preferably, you can use the form with separate components of
the reference. Any of the arguments can be either variables or constant. Here are some examples:

  #set( $reportDateCell = $dashboardProcessor.getCell('Dashboard', 'D', 4)) 

  #set( $targetRow = $dashboardProcessor.getRow('Dashboard', 'B', 'G', $rowIndex)) 

  #set( $targetRange = $dashboardProcessor.getRange('DataSheet3', 'A', 'F'))
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Getting Data from Reports

To get report data, call the method $dashboardProcessor.getReportData() with the fully qualified report name or the variable that contains the name.
For example,

#set($report1Data = $dashboardProcessor.getReportData($report1))

#set($report2Data = $dashboardProcessor.getReportData('/My Reports/Entity Distribution by Criticality'))

Normally, a report returns a list of lists for most types of reports.

85



Getting Data from Java Objects

Most of the time, you can obtain all data for a dashboard from reports, which is the preferred way of getting data. You can even define custom
reports through the RiskVision solution.

By default, the Java object $dashboardToolbox is loaded into the dashboard context. Contact Agiliance Customer Support for a complete list of
methods available from this object.

In order to get data from other Java objects, the objects must be loaded into the dashboard context using $dashboardContext.loadObject(). This
method requires two arguments, namely, the object name and the class name. In the example below, the object name is vulnerabilityUtil and the class
name is com..web.utils.VulnerabilityUtil.

$dashboardContext.loadObject('vulnerabilityUtil', 'com..web.utils.VulnerabilityUtil')

Once this object is loaded, you can call any of its public methods. For example, the two lines below get the top 20 vulnerabilities that have been
found on all entities in the system:

 #set($maxRows = 20)

 #set($topVulnerabilities = $vulnerabilityUtil.getTopVulnerabilitiesForAllEntities($maxRows))

Consult Agiliance Customer Support for Java objects available for this purpose.
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Populating The Target Range, Row, Column, Or Cell

The dashboard processor (i.e., $dashboardProcessor) provides the following methods for populating a target cell, row, column, and range using the
data from reports, Java objects, and/or parameters:

1. A single cell:

  setCellValue($cell, $cellData) 

2. A single row:

  setRowValues($row, $rowData) 

3. A single column:

  setColumnValues($column, $columnData) 

4. A range:

  setRangeValues($range, $rangeData)

Here are some examples:

 $dashboardProcessor.setCellValue($controlNameCell, $control.getCaption())

 #set($rowData = [$v.getCaption(), $v.getDescription(), $v.getDefaultSeverity(), $count])

 $dashboardProcessor.setRowValues($targetRow, $rowData)

 $dashboardProcessor.setRangeValues($report3DataRange, $report3Result)

Note that one can nest the three calls that define a data destination, get the data, and populate the target cell/row/column/range into a single call, at
the expense of reduced readability. Here is an example of such:

$dashboardProcessor.setRangeValues($dashboardProcessor.getRange('DataSheet3', 'A', 'F'), $dashboardProcessor.getReportData('/My
Reports/Entity Distribution by Criticality'))
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Returning the Content of the Resulting Dashboard

At the end of the rendering section, make the following method call to return the resulting Excel workbook:

 $dashboardProcessor.getDashboardContent()

This call makes it possible for the dashboard user to view or download the results.
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Example 1

This example produces a text-only HTML report that describes a Program that is specified when the report is run. Because the Program is specified
as a parameter, this example report will be able to describe any Program.

In this sample output, the name, description, and properties, such as owner and status, reflect the run-time Program parameter selected.

Creating a Template in RiskVision

The first step is to create the template and open the editor to begin editing the HTML template.

1. Go to Analytics > Dashboards and Reports. On the landing page, click New Dashboard.

2. In the New Dashboard or Report dialog, enter a name for your sample custom report, such as My Example 1. Enter a description, header, and
footer, or skip those fields, since they are optional and not the focus of this example.

3. For the layout, select HTML Report, and click New.

4. The RiskVision editor appears. Either enter or copy-and-paste the dashboard template content into the editor.

Creating an HTML template

The report template is a straightforward HTML file, with a head section and a body section, and some references to the Velocity template language.
Lines that start with '#' are Velocity directives, and a number of Velocity variables are pre-defined. Within your HTML markup, you can refer to
Velocity variables by name, preceded with a '$'.

The first step is a Velocity directive to create a variable called $program.

#set($program = $dashboardParameters.getProgram("program1", "Program"))

This line uses the predefined Velocity variable $dashboardParameters. This variable acts like an object in that it has a number of methods that act
upon it. In this case, the code invokes the method $dashboardParameters.getProgram. When the report is run, RiskVision will detect statements
such as this one and build a set of parameters for the report. This statement requests a parameter of type Program which can be called 'program1' in
the context of the report template. Because we're using the #set directive, however, the Velocity reference to the Program parameter will be the
variable $program. Notice that we did not have to #set $dashboardParameters. That variable, and a few others, are pre-defined in the RiskVision
report context.

It is convenient to establish report parameters first, but it is not required. We could embed the getProgram() call in the HTML itself, for example.
Setting up variables that refer to parameters separately from the HTML code makes it easier to maintain the HTML template in the future.

Next, create a familiar HTML document that looks something like this:
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#set($program = $dashboardParameters.getProgram("program1", "Program"))

>

///Program Name will go here///

///Program Description///

///Display selected Program properties///
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To display the program name, invoke the getName method on the program variable, just as you invoked the getProgram method on the pre-defined
dashboardParameters object.

$program.getName()

To display the program description, invoke the getDescription method on the program.

$program.getDescription()

In a similar fashion, fetch various properties of the program using different methods. Label the results using ordinary HTML text. To differentiate, we
have wrapped the labels in (bold) tags and wrapped the property values in (italic) markup. The last two lines invoke methods
(getRaWorkflowTemplate and getSurveyTakingPreferences) on the program object that return objects, rather than strings. We invoke the
getName() method on these objects. The Velocity syntax allows us to run these method invocations together using the dot ('.') operator. The
'program' object has a method called 'getSurveyTakingPreferences' that returns an object that has a method called 'getName' that returns a
string.

Program key information

Program Name: $program.getName()

Program Description: $program.getDescription() 

Program Owner: $program.getAuthor() 

Program Status: $program.getStatusDB() 

Program Workflow: $program.getRaWorkflowTemplate().getName() 

Survey Taking: $program.getSurveyTakingPreferences().getName() 

Saving the New HTML Report

After the HTML template has been entered into the editor:

1. Click OK to close the editor

2. Click OK to save the report

The new report runs immediately. Because the template includes a call to getProgram(), RiskVision prompts for a program. The next time the
report is run, it will use the program selected the first time it was run. To select a different program, click Parameters on the report display page.

Example Template

The complete HTML template for this example is:

#set($program = $dashboardParameters.getProgram("program1", "Program"))

>
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$program.getName()

$program.getDescription()

Program key information

Program Name: $program.getName()

Program Description: $program.getDescription() 

Program Owner: $program.getAuthor() 

Program Status: $program.getStatusDB() 

Program Workflow: $program.getRaWorkflowTemplate().getName() 

Survey Taking: $program.getSurveyTakingPreferences().getName() 
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Subsequent examples are more complicated and include charts to visualize the data, but they will build logically on this example.

The next example, Example 2, adds a chart to this report.
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Example 2

This example builds on Example 1. It produces an HTML report that describes a Program and includes a chart. Because the Program is specified as a
parameter, this example report will be able to describe any Program.

This example will focus on adding the chart. Most of the HTML template is described in more detail in Example 1.

Setting up Parameters

The report template is a straightforward HTML file, with a head section and a body section, with some references to the Velocity template language.
Lines that start with '#' are Velocity directives. A number of Velocity variables are pre-defined. Within your HTML markup, you can refer to Velocity
variables by name, preceded with a '$.'

The first step is a Velocity directive to create a variable called $program.

#set($program = $dashboardParameters.getProgram("AuditProject.id1", "Program"))

Next, initialize the chart:

$dashboardParameters.initChart("Shared Reports/System/Project Reports/Entities in Project by Criticality",
"large")
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The long name, "Shared Reports/System/Project Reports/Entities in Project by Criticality," refers to a specific chart in the tree hierarchy. The first
argument to the initChart method is the URL of the chart. The second argument can be "large" or "small."

Note: URLs are not affected by changes to UIDictionary.xml. By editing that file, users can change the display of terms

such as 'System' or 'Reports.' Because URLs do not change, your custom reports do not have to be updated if

UIDictionary.xml is changed.

Adding the Chart

You can add the chart to the bottom of the text-only in Example 1 by appending the following HTML. In this example, you can arbitrarily limit the
chart to 50% of the window width, but this can be specified in absolute units.

$dashboardParameters.getChart("Shared Reports/System/Project Reports/Entities in Project by

Criticality")

To display the program name, invoke the getName method on the program variable, just as you invoked the getProgram method on the pre-defined
dashboardParameters object.

Example Template

The complete HTML template for this example is:

#set($program = $dashboardParameters.getProgram("AuditProject.id1", "Program"))

$dashboardParameters.initChart("Shared Reports/System/Project Reports/Entities in Project by Criticality","large")

>
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$program.getName()

$program.getDescription()

Program key information

Program Name: $program.getName()

Program Description: $program.getDescription() 

Program Owner: $program.getAuthor() 

Program Status: $program.getStatusDB() 

Program Workflow: $program.getRaWorkflowTemplate().getName() 

Survey Taking: $program.getSurveyTakingPreferences().getName() 
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$dashboardParameters.getChart("Shared Reports/System/Project Reports/Entities in Project by Criticality")

The next example, Example 3, explains how to include multiple charts in a report.
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Example 3

This example builds on Example 2, producing an HTML report that describes a Program with two charts. Because the Program is specified as a
parameter, this example report will be able to describe any Program.

This example will focus on the charts. Setting up the HTML template itself is described in more detail in Example 1.

Setting up Parameters

The report template is a straightforward HTML file, with a head section, a body section and some references to the Velocity template language. Lines
that start with '#' are Velocity directives, and a number of Velocity variables are pre-defined. Within your HTML markup, refer to Velocity variables by
their name, preceded with a '$.'

As in Example 2, issue a Velocity directive to create a variable called $program.

#set($program = $dashboardParameters.getProgram("AuditProject.id1", "Program"))

Next, initialize the charts:

$dashboardParameters.initChart("Shared Reports/System/Project Reports/Entities in Project by Criticality", "large")

$dashboardParameters.initChart("Shared Reports/System/Compliance/Compliance Score in a Project for Children of a Control","large")
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In this case, use the Velocity #set directive to attach the second chart to a variable, $report_1, you can insert into the HTML later.

#set($report_1 = $dashboardParameters.getChart("Shared Reports/System/Compliance/Compliance Score in a Project for Children of a
Control"))

Because the result of the getChart method invocation is assigned to the variable $report_1, place the chart wherever it is needed by simply
embedding the Velocity variable in the HTML code. At runtime, the variable reference is replaced with the graphical chart:

$report_1

Adding the Charts

For this example, label the charts using Velocity method calls.

Entities in Program $program.getName() by Criticality

$dashboardParameters.getChart("Shared Reports/System/Project Reports/Entities in Project by

Criticality")

Compliance Score for Children of Assigned Controls in Program $program.getName()

$report_1

To display the program name, invoke the getName method on the program variable, just as you invoked the getProgram method on the pre-defined
dashboardParameters object.

Example Template

The complete HTML template for this example is:
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#set($program = $dashboardParameters.getProgram("AuditProject.id1", "Program"))

$dashboardParameters.initChart("Shared Reports/System/Project Reports/Entities in Project by Criticality",

"large")

The next example, Example 4, explains how to include multiple charts in a report.
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Example 4

This example builds on Example 3, producing an HTML report that demonstrates looping and conditional code in Velocity and enumerates the
children of selected objects. The code also shows how to create a multi-page report using CSS facilities.

This is an advanced example. Setting up the HTML template itself is described in more detail in Example 1.

Setting up Parameters

As in the previous examples, issue a Velocity directive to create a variable based on run-time parameters.

#set($regulation = $dashboardParameters.getControl("PolicySet.id1", "Control or Questionnaire"))
#set($assessmentProject = $dashboardParameters.getProject("AuditProject.id1", "Program"))
$dashboardParameters.initChart("/Shared Reports/System/Controls Compliance/Compliance Level of a Control in a Project", "small")
$dashboardParameters.initChart("/Shared Reports/System/Compliance/Compliance Score in a Project for Children of a Control","large")

Inserting Page Breaks

You can produce arbitrarily complex HTML code, including Cascading Style Sheets (CSS), Javascript, and other technologies that are beyond the
scope here to discuss. The following code illustrates how embedding CSS can paginate the output of your report. First, define the style in head:

This code specifies a page break before all paragraphs of class "breakpage."

To start on a fresh page, insert the HTML:

Looping

Iterating over a set of objects is accomplished using the #foreach Velocity directive. The following loop prints the title and description of each child of
the specified Program.

#set($sections =
$DT.getChildren($regulation))
#foreach($section in $sections)

$section.getDescription()

#end

Note that $DT is an abbreviation for $dashboardTemplate.

Conditional Output

It can be useful to output certain HTML snippets only under particular circumstances. Velocity supports the #if directive for this purpose. You can set
up index variables in your loop in order to output HTML only at the end of the loop, for example, or at the beginning.
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#set ($i = 1)
#foreach($section in $sections)
#if ($i != 1 )

#end

#set ($i = $i+1)

#end

This code establishes an index variable, $i, and outputs a horizontal rule (

) every time through the loop except the first. This will output section 1, horizontal rule, section 2,
horizontal rule, and so on.

Example Template

The complete HTML template for this example is:

#set($regulation = $dashboardParameters.getControl("PolicySet.id1", "Control or Questionnaire"))
#set($assessmentProject = $dashboardParameters.getProject("AuditProject.id1", "Program"))
$dashboardParameters.initChart("/Shared Reports/System/Controls Compliance/Compliance Level of a Control in a Project", "small")
$dashboardParameters.initChart("/Shared Reports/System/Compliance/Compliance Score in a Project for Children of a Control","large")

>

$regulation.getTitle()

$regulation.getDescription()
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Compliance / Risk Summary for $regulation.getTitle()

>

Project key information

Project Name: $assessmentProject.getName()

Project Description: $assessmentProject.getDescription() 

Project Owner: $assessmentProject.getAuthor() 

Project Status: $assessmentProject.getStatusDB() 

Project Workflow:

$assessmentProject.getRaWorkflowTemplate().getName() 

$dashboardParameters.setControl("/Shared

Reports/System/Controls Compliance/Compliance Level

of a Control in a Project", "PolicySet.id1", $regulation)

$dashboardParameters.getChart("/Shared
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Survey Taking:

$assessmentProject.getSurveyTakingPreferences().getName()

Regulation or Control Framework: $regulation.getTitle() 

Regulation or Control

Desciption:$regulation.getDescription()

Reports/System/Controls Compliance/Compliance Level

of a Control in a Project")

$dashboardParameters.setControl("/Shared

Reports/System/Compliance/Compliance Score in a Project for

Children of a Control", "PolicySet.id1", $regulation)

$dashboardParameters.getChart("/Shared

Reports/System/Compliance/Compliance Score in a Project for

Children of a Control")

#set ($i = 1)

#set($sections = $DT.getChildren($regulation))

#foreach($section in $sections)

#if ($i!=1 )
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#end

#set ($i = $i+1)

$section.getDescription()

$dashboardParameters.setControl("/Shared Reports/System/Compliance/Compliance Score in a Project for Children of a

Control", "PolicySet.id1", $section)

$dashboardParameters.getChart("/Shared Reports/System/Compliance/Compliance Score in a Project for Children of a

Control")

#set($sections_b = $DT.getChildren($section))

#foreach($section_b in $sections_b)

$section_b.getTitle()

$section_b.getDescription()
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#end

#end

106



Example 5

This example is created using the "An Entity Compliance Summary" system HTML report and it contains the Program and Entity parameters. The
objective of this example is to show you how to embed the entity creation feature in dashboard. To modify the HTML code of the "An Entity
Compliance Summary" report, you must copy the report to the My Dashboards folder or to any folder for which you have the ownership.

Setting up the Report

After you copy the report, modify the report template to include the following lines in the HTML code. To modify a report template, see Modifying a
Template.

#if ($dashboardContext.isRendering()) 
 

 New Asset  onclick='$DT.getNewAssetURL() '> Click to create new Asset
 
 

 #end

Dashboard Output

After adding the HTML code, run the dashboard, and input the parameters to view the dashboard as:

The dashboards contains a Create Entity button that will launch the entity creation wizard.

Unless you have the Create entity permission, creating an entity is not possible on the dashboard even if the feature is visible to you.
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Understanding Simplified Schema

RiskVision defines "views" in the underlying database tables in order to make references to certain objects, such as tickets, exception requests, and
incidents, easier to specify in custom dashboards and reports.

Views are similar to tables in that tables have columns and rows, but views are references to more complicated relational tables in the database.

The following views are pre-defined:

aglrt_comments

View Column Name Data Type

comment_id bigint(20)

associated_object_id bigint(20)

Comment text

Type varchar(64)

Entered By varchar(255)

EnteredOn timestamp

aglrt_attachments

View Column Name Data Type

attachment_id bigint(20)

owning_object_id bigint(20)

Caption varchar(4000)

Description varchar(4000)

Uploaded By varchar(255)

Uploaded On timestamp

Size int(11)

Expires On timestamp

aglrt_exceptionrequestworkflow

View Column Name Data Type

exceptionrequest_id bigint(20)

Stage Name varchar(255)
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Current int(0)View Column Name Data Type

aglr_exception_request

View Column Name Data Type

exceptionrequest_id bigint(20)

Compensatory Controls
bit(1) (1=include compensatory

controls)

End Date timestamp

Next Review timestamp

Override Subcontrol Response

Score
float

Reason for Exception varchar(4000)

Start Date timestamp

Start the Recurrence on timestamp

Title varchar(255)

and again at timestamp

aglrt_erworkflowowner

View Column Name Data Type

exceptionrequest_id bigint(20)

Stage Name varchar(255)

Owner text (first + initial + last)

aglrt_workflowhistory

View Column Name Data Type

payload_id bigint(20)

Date timestamp

Stage varchar(255)

Action varchar(255)

To Stage varchar(255)
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User varchar(255)

Comment varchar(4000)

target_user varchar(4000)

View Column Name Data Type

aglrt_changehistory

View Column Name Data Type

object_id bigint(20)

Who varchar(255)

When timestamp

Change text

aglrt_ticketworkflow

View Column Name Data Type

ticket_id bigint(20)

Stage Name varchar(255)

Current
int(0) (stage

name)

aglr_ticket

View Column Name Data Type

ticket_id bigint(20)

Category varchar(255)

Description text

Disposition varchar(128)

End timestamp

Exception Expiration

Date
timestamp

Owner varchar(255)

Planned End timestamp

Planned Start timestamp
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Priority varchar(32)

Progress smallint(6)

Start timestamp

Status varchar(255)

Title varchar(255)

Type varchar(64)

Workflow varchar(255)

View Column Name Data Type

aglrt_ticketlinkedobjects

View Column Name Data Type

ticket_id bigint(20)

object_id bigint(20)

Type varchar(128)

Name varchar(255)

Owner varchar(511)

Criticality varchar(128)

aglrt_ticketworkflowowner

View Column Name Data Type

ticket_id bigint(20)

Stage Name varchar(255)

Owner text (first + initial + last)

aglrt_workflowhistory

View Column Name Data Type

payload_id bigint(20)

Date timestamp

Stage varchar(255)

Action varchar(255)

To Stage varchar(255)
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User varchar(255)

Comment varchar(4000)

target_user varchar(4000)

View Column Name Data Type

aglr_incident_action

View Column Name Data Type

incidentaction_id bigint(20)

Action Description varchar(4000)

Action Summary varchar(128)

Action Time timestamp

Resolution varchar(128)

Status varchar(64)

aglv_incidentowners

View Column Name Data Type

incident_id bigint(20)

Stakeholder text (first + initial + last)
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About JasperReports Server

RiskVision offers a third-party business intelligence tool called JasperReports Server that you can use for building sophisticated charts and
dashboards. JasperReports Server includes a wide variety of advanced report building techniques that you may use on existing RiskVision charts.

Some of the JasperReports Server key features include:

Ad Hoc Editor

Dashboards

Domain

Reports

Scheduler

If you are using Internet Explorer 10 to access JasperReports Server, make sure that you have disabled the Internet Explorer compatibility mode.
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Accessing The JasperReports Server

Any user who can log in to RiskVision and has the Dashboards and Reports View permission can access the JasperReports Server application. Once
logged into RiskVision application, go to Analytics > Analytics and Reporting to access the Jasper-Reports Server application. When you click the
Analytics and Reporting option the TIBCO Jaspersoft Server home page appears in a tabbed browser.

Depending on the Jasper role or RiskVision role assigned to you, a default home page with options to perform one or more tasks appears. Click an
option to display menu items at the top. JasperReports Server menu can be used to perform the following:

1. Viewing Reports and Repository

2. Creating Ad-Hoc report, Dashboard, and Domain

3. Managing organizations, users, and roles
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JasperReports Server Key Features

This section describes major key features of JasperReports Server, including the concepts Ad hoc Editor, Dashboard, Domains, Reports, and
Scheduler.

To access the Jaspersoft documentation, go to Start > All Programs > Report Server > JasperReports Server Documentation.
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Ad Hoc Editor

The Ad hoc Editor is an easy-to-use report building utility that supports drag and drop. Typically, you use topics or domains to create reports on the
fly. Because of the drag and drop feature, this editor will reduce ambiguity and produces the desired layout and output. During report design, you can
format the report appearance, switch the report type (table, crosstab, and chart), sort the report data, edit labels for the data displayed in a report, add
custom fields to perform mathematical calculations and so on.

For information about how to create a report and format the appearance of a table, chart, and crosstab report types using the Ad Hoc Editor, see
Creating an Ad Hoc Table Report, Creating an Ad Hoc Chart Report, and Creating an Ad Hoc Crosstab Report.

In order to explore more advanced features and options in the Ad hoc Editor, refer to the sections, "Designing an Ad hoc Report," "Creating a Report
from a Domain," "Formatting the Appearance of a Table," "Refining the Crosstab," and "Designing Charts," in the JasperReports-Server-User-Guide.
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Dashboard

JasperReports Server provides many user-friendly features to build interactive dashboards. Some of the advanced features are:

Including data from multiple sources by adding a URL to the dashboard

Display free text items on the dashboard. For example, add a title to the dashboard

Adding input parameters using a single control or multiple controls to update the dashboard’s data

Adjusting a dashboard’s layout

Setting the canvas size (dashboard display area) to adjust to your system’s screen resolution

For information about the content you can add to a dashboard, see "Dashboard Overview". To learn how to create a dashboard, see "Creating a
Simple Dashboard" in the JasperReports-Server-User-Guide.
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Domains

Typically, a database allows you to run a query across tables using various operations such as joins and derived tables to provide on-going reports.
RiskVision avoids the difficulties of direct database access by providing a collection of pre-defined domains. A domain is a data provider that acts as a
logical layer between your reports and the database. A domain represents a subset of the tables and columns in the RiskVision database. You can use
domains to create reports using the Ad Hoc editor. Using a domain, you can write SQL queries, perform join operations, add filters, and provide
security to specify what data can be accessed by a particular group of users. The modifications that you perform on a domain do not alter the
database.
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Reports

Reports can be exported to various output formats such as Adobe Acrobat (PDF), Microsoft Excel (XLS or CSV), Microsoft Word (DOCX or RTF),
Adobe Flash (SWF), OpenDocument Text (ODT), Open Document Spreadsheet (ODS), and Microsoft Open XML Format Spreadsheet (XLSX). For
information about how to run and export a report to an appropriate format, see Predefined Reports in JasperReports Server, Running Predefined
Reports in JasperReports Server, and Viewing and Running a Report in the Ad Hoc Editor.
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Trend Metrics

An important part of risk management is knowing whether you are doing a better or worse job of managing your risk. By allowing you to view
specific data over time, trending reports provide this information. The Metrics Trend Generator feature provides a means to specify the data you want
to trend as well as reports to view this data. The Metrics Trend Generator feature allows you to trend data related to tickets and vulnerabilities.
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Enabling The Collection Of Trend Data

There are two types of configuration required in order to set up metrics trending:

Configure Jobs

Each type of trending object has its own dedicated job that runs to collect data for the object at predefined intervals. Therefore, there are jobs for
tickets and vulnerabilities. If you want to establish trending for either type of object you must first enable its job.

The TrendingSchedulerConfiguration.xml allows you to configure job-level settings. These settings consist of the following:

Whether the job is enabled. By default, enabled is set as false. To turn on the job, you need to set enabled to true as follows: true. You can
also enable the job by going to the RiskVision Administration module, selecting the Scheduled Jobs page, finding the relevant job, clicking in
the checkbox to the left of the job name, and selecting the Activate button at the top of the page. You can then click on the name of the job to
view and change the execution schedule of the job. The names of the job in the Scheduled Jobs page is Trending Data Collection for Tickets

The frequency of trending data collection. The line of the TrendingSchedulerConfiguration.xml file where this setting is made is as follows:
daily. Values that can be inserted into the line are daily, weekly, monthly, and yearly.

Time each day that the job is run. The line of the TrendingSchedulerConfiguration.xml file where this setting is madeis as follows: hours,
minutes. For example, if the setting 22,0 was in place, the job would run every day at 10:00 PM. Note that the job cannot be run more
frequently than once per day.

Configure Tasks

Each job has multiple tasks related to the job. Each task represents a query that is run to obtain trending data that can be used for one or more
reports that bring back data related to the object type, whether they are tickets or vulnerabilities. By default, tasks are enabled. You can disable some
tasks while leaving the rest enabled, if you choose. To disable a task, you can change enabled=”true” to enabled=”false”.

You will notice that some tasks have a line that reads in part , such as the following: . If you decide to write trending data to the database on a daily
basis, you can use this feature to also create weekly summaries of data so that figures such as averages and standard deviations that are difficult to
calculate with daily rolled up daily data can be properly calculated. This feature will also create monthly data if it is set to either weekly or monthly.

The startOfWeek ="Sunday" expression treats Sunday as the first day of the week for purposes of writing weekly trend metrics to the database. The
start = "true" expression denotes that the trending data will be written to the database on the first day of the week while the end ="true" expression
results in the trending data being written to the database on the last day of the week.

There is also a line in the task, as seen in the sample below, that starts with groupBy. Changing the groupBy expression allows you to control how
you want to group the data returned by the trending query. For example, in the below sample task you can change from group by type to group by
stage.

 

 

 

owner, priority, ticket_type

 

 

 

Figure 1 - Sample task

Below is a list of tasks for the two trending jobs:

Tickets

Tickets

ticket_type_stage - Provides a list of the open tickets by type with average age and average stage age.
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ticket_owner_stage - Provides a list of the open tickets by owner with average age and average stage age.

ticket_owner_allstage-Provides a list of the closed tickets by owner with average age and average stage age.

ticket_type_allstage - Provides a list of the closed tickets by type with average age and average stage age.

ticket_priority_stage - Provides a list of the open tickets by priority with average age and average stage age.

ticket_risk_stage - Provides a list of the open tickets by risk with average age and average stage age.

owner_priority_type - Provides a list of the open tickets by risk with average age and average stage age.

closed_ticket_owner_stage - Provides a list of the average age, average stage age, standard deviation age, and standard deviation stage age
for closed tickets by owner.

closed_ticket_type_stage - Provides a list of the average age, average stage age, standard deviation age, and standard deviation stage age
for closed tickets by ticket type.

ticket_entityowner_stage - Provides a list of the average age, average stage age, standard deviation age, and standard deviation stage age
for closed tickets by owners of the entities linked to the tickets.
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Trending Database Table Structure

The purpose of this section of the Administrative Guide is to help you become familiar with the table structure of the trending database tables so that
you can create custom trending reports with the data in the database. Each table was designed to be flexible enough to accommodate multiple types
of trends.

There is a database devoted to each object and trending job. Therefore, there are 2 total trending-related database tables. Below is a list of these
tables with a categorization of the types of fields in each table:

agl_trending_ticket

The agl_trending_ticket table, as the name implies, contains trending data for tickets. The tasks for the trending job, covered earlier in this chapter,
execute the queries that populate the data in this table. The columns in this table and the type of data each column contains are as follows:

trending_type - This column labels the type of ticket trending data in the database row. You will need to refer to the type in your WHERE clause to
ensure your query is obtaining the type of data that you desire. The possible type values equate to the task names, which were covered earlier in this
section. Examples of trending type values include ticket_type_stage, ticket_priority_stage, and ticket_entityowner_stage.

current_interval - The starting point of each interval in which rollups to the trending table occur. If an object's job is set to run on a daily basis, then
there will be daily, weekly, and monthly rollups. All daily jobs will have the same current_interval, all weekly jobs share the same current_interval, and
all monthly jobs have the same current_interval. This field is designed for internal use.

collection_time - The time the record is created

quantity - Total number of tickets in a group (e.g. total tickets of a type)

is_closed - Total number of tickets that were closed during an interval.

is_opened - Total number of tickets that were created during an interval.

total_closed - At this collection time, the number of tickets in a closed state.

total_opened - At this collection time, the number of tickets in an open state.

avg_stage_age - Average days spent in the current stage.

avg_age - Average days from creation to close for closed tickets. For open tickets, this is calculated as the difference between the creation
date and the date the metric was written to the database.

std_stage_age - Standard deviation of stage age.

std_age - Standard deviation of age

groupby1_string - String that describes the group of trend metrics. For example, if the trending query is for tickets by owner, by priority, by
risk, and by type, the groupby1_string would be the owner's name.

groupby2_string - String that describes the group of trend metrics. For example, if the trending query is for tickets by owner, by priority, by
risk, and by type, the groupby2_string would be the priority of the group of tickets.

groupby3_string - String that describes the group of trend metrics. For example, if the trending query is for tickets by owner, by priority, by
risk, and by type, the groupby3_string would be the risk level of the group of tickets.

groupby4_string - String that describes the group of trend metrics. For example, if the trending query is for tickets by owner, by priority, by
risk, and by type, the groupby3_string would be the type of the group of tickets.

groupby5_string - String that describes the group of trend metrics. Most trending queries will not require a 5th groupby string, but this
column is here in case it is needed.

groupby1_number - Numerical value that is common to a group of tickets. Most queries will probably not use this field, but it could be useful if
a custom attribute that is represented by a number, such as Category, is added to the ticket object.

Groupby2_number - Numerical value that is common to a group of tickets. Most queries will probably not use this field, but it could be useful
if a custom attribute that is represented by a number, such as Category, is added to the ticket object.

Groupby3_number - Numerical value that is common to a group of tickets. Most queries will probably not use this field, but it could be useful
if a custom attribute that is represented by a number, such as Category, is added to the ticket object.
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Trending Ad Hoc Reports

The trending ad hoc reports are categorized as per the object folders in the Trending sub-folder under the Reports sub-folder in the Public folder.

In the Trending sub-folder, based on the data frequency collection the reports are categorized into folders, they are:

Daily

Weekly

Monthly
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List of Trending Ad Hoc reports by Tickets

The reports are categorized based on the data collection frequency of tickets. They are as follows:

1. Daily

2. Weekly

3. Monthly

The list of reports available under the hierarchy is as follows:

1. Daily

Daily Open Ticket Trend By Owner: Daily trend of the total number of open tickets by ticket owner for the last 60 days.

Daily Ticket Creation Trend By Owner: Daily trend of the total number of tickets created for ticket owners for the last 60 days

Daily Open Ticket Trend By Type: Daily trend of the total number of open tickets by ticket type for the last 60 days

Daily Ticket Creation Trend By Type: Daily trend of the total number of created tickets by ticket type for the last 60 days

Daily Open Ticket Trend By Priority: Daily trend of the total number of open tickets by ticket priority for the last 60 days

Daily Ticket Creation Trend By Priority: Daily trend of the total number of created tickets by ticket priority for the last 60 days

Daily Open Ticket Trend By Risk: Daily trend of the total number of open tickets by ticket risk for the last 60 days

Daily Ticket creation Trend By Risk: Daily trend of the total number of created tickets by ticket risk for the last 60 days

Daily Open Ticket Trend By Owner by Average Age: Daily trend of the average age of the total number of open tickets by ticket owner for the
last 60 days

Daily Open Ticket Trend By Owner by Standard Deviation of Age: Daily trend of the standard deviation of total number of open tickets by
ticket owner for the last 60 days

Daily Open Ticket Trend by Stage: Daily trend of the total number of open tickets by workflow stage for the last 60 days

Daily Ticket creation Trend by Stage: Daily trend of the total number of tickets created by workflow stage for the last 2 months

Daily Top Owners of Entities Linked to Open Tickets: Daily trend of open tickets linked to entities by entity owner for the last 60 days

Daily Top Owners of Entities Linked to Created Tickets: Daily trend of created tickets linked to entities by entity owner for the last 60 days

Daily Average Length in Workflow Stages for Closed Tickets: Daily trend of average length in workflow stages for closed tickets for the last
60 days

Daily Standard Deviation of Length in Workflow Stages for closed tickets: Daily trend of standard deviation of length in workflow stages for
closed tickets for the last 60 days

Daily Open Tickets Trend: Daily trend of the total number of open tickets by ticket priority for the last 60 days

Daily Tickets Closed by Owner: Daily trend of the total number of tickets closed by ticket owner for the last 60 days

Daily Tickets Closed by Type: Daily trend of the total number of tickets closed by ticket type for the last 60 days

Average Age by Stage for Closed Tickets by Ticket Type: Daily trend of average age of each workflow stage for closed tickets by ticket type
for the last 60 days

Average Age for Closed Tickets by Ticket Type: Daily trend of average age for closed tickets by ticket type for the last 60 days

Standard Deviation Age by Stage for Closed Tickets by Ticket Type: Daily trend of standard deviation of age of each workflow stage for
closed tickets for the last 60 days

Standard Deviation Age for Closed Tickets by Ticket Type: Daily trend of standard deviation of age for closed tickets for the last 60 days

Weekly

Weekly Average Length in Workflow Stages for Closed Tickets: Weekly trend of average length in workflow stages for closed tickets for the
last 52 week

Weekly Open Ticket Trend By Owner by Average Age: Weekly trend of the average age of the total number of open tickets by ticket owner
for the last 52 week

Weekly Open Ticket Trend By Priority: Weekly trend of the total number of open tickets by ticket priority for the last 52 week

Weekly Open Ticket Trend By Type: Weekly trend of the total number of open tickets by ticket type for the last 52 week

Weekly Ticket Creation Trend By Priority: Weekly trend of the total number of created tickets by ticket priority for the last 52 week

Weekly Ticket Creation Trend By Type: Weekly trend of the total number of created tickets by ticket type for the last 52 week
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Monthly

Monthly Average Length in Workflow Stages for Closed Tickets: Monthly trend of average length in workflow stages for closed tickets for the
last 24 months
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Running A Trending Report

To run a report such as the Daily Open Ticket Trend by Owner predefined report, follow the steps below.

To view or run a predefined trending report:

1. Go to Analytics > Analytics and Reporting to launch the JasperReports Server.

2. Go to View > Repository, and expand the Trending folder under the Reports folder that is present in the Public folder.

3. Select the Daily folder to display the list of reports.

4. Right-click in the Daily Open Tickets by Owner report row, and select Run in the context menu.

5. After you run the report, click the  icon and choose As PDF to open the report in a tabbed browser. In the browser (Mozilla), go to File >

Save Page As... to save the report. If you want to export the report as a Word document, click the  icon again and choose As DOCX to
open the report using Microsoft Word. In the Microsoft Word application, go to File > Save to save the report.
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6. After you run the report, click the  icon and choose As PDF to open the report in a tabbed browser. In the browser (Mozilla), go to File >

Save Page As... to save the report. If you want to export the report as a Word document, click the  icon again and choose As DOCX to
open the report using Microsoft Word. In the Microsoft Word application, go to File > Save to save the report.
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Ad Hoc Metric Reports

The ad hoc metric reports are categorized as per the metric collected in the Trending sub-folder under Reports sub-folder in the Public folder.

In the Trending sub-folder based on the data frequency collection the reports are categorized into folders, they are:

Daily

Monthly

Weekly

List of Ad Hoc Metric reports

The list of reports available under the hierarchy is as follows:

Daily
Daily Count Metric

Monthly
Monthly Count Metric

Weekly
NewAssetsSinceLast7Days

NewIncidentsSinceLast7Days

NewTicketsSinceLast7Days

Weekly Count Metric

For the Oracle setup the below mentioned reports will not exist:

NewAssetsSinceLast7Days

NewIncidentsSinceLast7Days

NewTicketsSinceLast7Days
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About Trending Custom Queries

The trending_custom_queries.xml file is used to define queries that get executed. Below is the structure of an example ad hoc query in the
trending_custom_queries.xml file:

INSERT INTO agl_trending_adhoc

( trending_type, current_interval, collection_time, long1, long2, long3) SELECT ':TASK_KEY',

:CURRENT_INTERVAL,

current_timestamp(3), asset_count, vuln_count, vuln_count/asset_count

FROM (select count(distinct (asset_id)) asset_count, count(distinct(vul- nerability_id)) vuln_count from
agl_asset_to_vulnerability a

WHERE ((a.av_flags & 3) = 2) ) atv_table

]]>

The parts of the entry that must be made for each query in the XML file are as follows:

".

Key - This is the name given to the query. It will be referred to in the Trend-
ingSchedulerConfiguration.xml file and in the trending_type column of the agl_trending_adhoc table.

displayName - Indicates what the values placed in the column the displayName is mapped to rep- resent.

]]> - Closing of the CDATA clause.

- Closing of the query for the entry.

Queries that are created must conform to the following constraints set by the agl_trending_adhoc table
columns:

8 string values

8 long values

2 float values

2 boolean values
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Ad Hoc Trending Metrics

The Ad Hoc Metrics feature provides a means to trend virtually any query, provided it fits within the constraints imposed by the table that the query
results are written to, the agl_trending_adhoc table. The feature works by automatically executing queries in one XML file, the
trending_custom_queries.xml file, that are enabled in another XML file, the TrendingSchedulerConfiguration.xml file. These queries can be executed
on a daily, weekly, or monthly basis. The frequency can be set in the TrendingSchedulerConfiguration.xml file or in the RiskVision user interface by
going to the Administration -> Scheduled Jobs page and scheduling the Trending Data Collection for Ad Hoc Views job to the desired interval.
Before providing instructions for enabling existing queries and creating new ones, we will provide an overview of the files used to define the queries
and control their execution, the trending_custom_queries.xml and TrendingSchedulerConfiguration.xml files.
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Scheduler

The Scheduler can create multiple jobs for an individual report. This means you can schedule the same report multiple times to run individually at a
specified future date and time. In JasperReports Server, a user who creates a schedule can view, modify, stop or delete a scheduled job as well. Each
scheduled output can be incorporated with a date and time stamp to determine when the report was run. When a scheduled report fails,
JasperReports Server notifies you through internal messages to help you understand the reason behind the scheduling problem.

To familiarize yourself with JasperReports Server Scheduler, see Scheduling a Report in JasperReports Scheduler and Modifying a Scheduled Job.

In order to explore more advanced features and options in the JasperReports Server Scheduler, refer to the sections "Viewing Schedule Jobs,"
"Scheduling a Report," "Specifying Job Recurrence," "Changing Job Schedules," "Stopping a Job from Running," "Running a Job in the Background,"
"Adding a Date/Time Stamp to Scheduled Output," and "Event Messages" in the JasperReports-Server-User-Guide.
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Modify Drill-Down Reports

As of RiskVision version 9.3.5, drill-down reports will now render in five seconds or less. In order to leverage these performance improvements, the
$P{REPORT_SCRIPTLET}.getEncryptedIdString  property must be removed from the report's code. When creating a new report, simply do

not add this property during the creation process. For pre-existing reports, there are a few more steps to follow.

To modify existing reports:

1. Export the desired drill-down report zip file. The exact location will vary from user to user. For example, the report file could be located in the
exportAllApp\resources\organizations\Agiliance\Reports\POC_Reports\Chevron\All_Vulnerabilities_by_Application_files folder.

2. Open the jrxml.data file.

3. Search for jsp.

4. Remove the $P{REPORT_SCRIPTLET}.getEncryptedIdString  property from every line of code containing jsp.

5. Save the file.

6. Re-zip the report and re-import it. The corresponding report will now render faster.
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Predefined Reports in JasperReports Server

RiskVision has provided a number of predefined reports in the JasperReports Server. These predefined reports assists in functionality such as being
able to export a report to a wide variety of outputs (PDF, Excel, RTF, CSV, DOC, XLSX, and so forth) and an option to send a report to many
recipients when scheduling a report. Also, predefined reports can be copied to a folder in the repository so that it can be tailored using the iReport
Designer Professional application to alter a report according to your preferences.

In JasperReports Server, the predefined reports are found in the Reports sub folder of the Public folder on the View > Repository menu.

Predefined reports exist for the following RiskVision objects:

Assessment

Incident

Policy

Program

Disclaimer: Please be aware that sections explaining the Jaspersoft report creation or scheduling features are intended to provide an overview of
essential Jaspersoft functionality that relates to RiskVision. It is not intended to provide a thorough discussion of the full range of Jaspersoft features.
Therefore, RiskVision recommends referencing the JasperReports Server documentation for exploring more advanced features and options.
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Running Predefined Reports In JasperReports Server

To run a predefined report in JasperReports Server, your RiskVision role must have the Dashboards and Reports Author permission.

Scenario: Guard First is a major health care and medical center specialized in curing short-term illness and provides unique health insurance. As a
program owner at Guard First, you are given a task to present a report on the assessment details of the 'GF_Risk_Audit' program and submit the report
in the PDF and DOCX formats. To accomplish your task, you will run the 'Program Assessment Details' predefined report.

The rest of this section provides the procedural steps that describes how to run the 'Program Assessment Details' predefined report.

To view or run a predefined report:

1. Go to Analytics > Analytics and Reporting to launch the JasperReports Server.
2. Go to View > Repository, expand the Reports folder that is present in the Public folder, and select the Program folder to display the list of

reports.

3. Because your goal is to view the assessment details of the 'GF_Risk_Audit' program, right-click in the Program Assessment Details report row,
and select Run in the context menu.

4. A few predefined reports such as Program Assessment Details and Program Details, require input parameters before they display the data.
When the Input Controls prompt box appears, click the drop-down box to choose 'GF_Risk_Audit,' and Click OK to display the report. Click
Apply to preview the report data in the background of Input Controls prompt box.

5. If the report that is displayed is spanned across several pages, you will find arrows at the top or bottom of report view. Click arrows to go to
next or the previous page, or first or last page of the report.

6. After you run the report, click the  icon and choose As PDF to open the report in a tabbed browser. In the browser (Mozilla), go to

File > Save Page As... to save the report. Click the  icon again and choose As DOCX to open the report using Microsoft Word. In the

Microsoft Word application, go to File > Save to save the report.
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7. Optional. If you want to modify the report results, click the  icon to bring up the Input Controls prompt box. Choose a filter value to
view another program assessment details and click OK.
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Working with the Ad Hoc Editor

You can create custom reports using the Ad Hoc Editor if predefined reports do not meet your report objective. Creating an Ad Hoc report requires a
predefined or custom-created dmain.

RiskVision recommends obtaining the JasperReports Server domain relationship diagrams from the RiskVision administrator in order to understand
the relationship between the tables if you are creating an ad hoc report using the predefined domains.
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Creating An Ad Hoc Table Report

Scenario: As an Application Security Specialist at Guard First, you are given a task to prepare a table report that shows the number of vulnerabilities
reported by scanners. To meet this report objective, you will need to use the 'Vulnerabilities (Instances)' domain.

The rest of this section provides the procedural steps that will help you create an Ad Hoc table report using the 'Vulnerabilities (Instances)' domain.

To create a table report:
1. Go to Analytics > Analytics and Reporting to launch the JasperReports Server.

2. On the Create menu, click Ad Hoc View.

3. The Data Chooser: Source dialog appears. Click the Domains, locate and select the Vulnerabilities (Instances) domain, and click Choose Data.

recommends selecting the data source as topic if you have previously created an ad hoc report using a domain and want to build a new report

from the topic that you saved earlier.

4.  The Data Chooser... options appear when the Fields tab is selected. On the Fields tab, the Source box lists the tables present in the
'Vulnerabilities - Instances domain. To select fields or tables, you can drag, double-click, or Ctrl-click and click > to move items to the Selected
Fields box. Double-click the 'Entity' and 'Vulnerability' tables to move all fields from these two tables to the Selected Fields box.
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5. Optional. Click the Pre-filters tab to create a filter using the selected fields. By creating a filter, you are restricting the data that appears in the
report. To create a filter, expand a table, and double-click the field. After the field appears in the Filters pane, select the drop-down list next to
the field to choose the type of operation, choose the field value, and click OK. Click Cancel to remove the filter.

You can create filters in the Report Editor.

6. Optional. Click the Display tab to change the display name and list type for the fields, and to re-order them. To change the display name,
double-click the field, and rename it. To re-order the field hierarchy, select the appropriate list type, and use up or down arrows to move up or
down. Use arrows that are pointing to the horizontal line to move fields to the top or bottom.

7. Click the Save as Topic tab to save the topic for later use. Enter 'GF_Vulnerability_Data' in the Name field (required)for the topic, optionally
enter description in the Descriptionfield, and click Browse to choose a location in the repository where the topic will be saved for reuse. By
default, the topic will be saved to the  \adhoc\topics  location in the repository.
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8. After specifying all the details on the tabs, click Table.

9. The Ad Hoc Editor appears. In the Fields pane, expand the tables, and ctrl-click the fields: Title, Identifier, Source, Cvss Score, Default
Severity,Modified Date, and Published Dateto drag them into the Columns layout band. To select a field, you can also right-click the field, and
choose Add as Group or Add as Column. Whenever you add field(s), the JasperReports Server simultaneously updates the data in the report.

10. Select Full Data in the drop-down list to view the entire data in ad hoc editor. Now that you have added the fields, the unformatted report
appears as:
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11. Click the  icon and choose Save Ad Hoc View and Create Report. In the Save Ad Hoc View and Create Report dialog, enter
'GF_VulnerabilitiesfromScannersr' in the Data View (required)field and enter a name in Report Name (required)field.
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Formatting The Appearance Of A Tabular Report

After you create the 'GF_VulnerabilitiesfromScanners' data view, the appearance can be improved; by changing the labels, formatting the fields, adding
space between columns, and so on.

The rest of this section will help you understand how to format the 'GF_VulnerabilitiesfromScanners' data view.

To format the table report:
1. Optional. To open the report,

1. In the JasperReports Server, click Search Results on the View menu. In the Searchfield, enter the view name, and click the search icon.
The Search results appear, displaying reports and views that match the search criteria.

Or

If you know the location of view in the repository, go to View > Repository menu.

2. After you locate the ad hoc view, click the view, or right-click in the view row and choose Open  in the context menu.

2. Optional. At the top of the Fields pane, click  and choose Change Source or Select Fields. If you choose Change Source and perform any
changes, all the report data and its formatting is lost. Hence, it is recommended to preserve the source. To add or remove fields, choose Select
Fields. You can remove those fields which are not in use in the report.

3. At the top of table, click the text Click to add a title and enter the title as 'Vulnerabilities from Scanners.'

4. Optional. To change the display name of a table column, right-click the column, and choose Edit Label in the context menu. Enter a new display
name in the label field and click Submit. Similarly, change the display name for other columns.

5. Optional. If a column name is lengthy and occupying more space than its data, right-click the field and choose Delete Label in the context menu.
However, the label is not displayed when you run the report.

6. In Measures, select the Spacer and drag-and-drop into the table before the 'Identifier' column to add space to; help you read data easily.
Similarly, add a Spacer to adjust the spacing for Source and Cvss Score columns as well.

7. Mouse over the column,and move the mouse to the column border. When the splitter appears, hold the left-click and drag the mouse left or right
to adjust the column width. This enables the report to fit within the margins of the page layout.

8. Optional. Right-click a column in the report and choose Move Left or Move Right move a column left or right in the table.

9. Optional. For fields displaying date, right-click in the column, go to Change Date Format in the context menu, and choose a format, Oct 16,
2012 9:43:42 PM, for example.

10. Now that you have applied the formatting, the 'GF_VulnerabilitiesfromScanners' table report appears as:

11. 
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12. Click the  icon and choose Save Ad Hoc View to save the view.

 Limitation 

When a table report containing a column displaying the Ids of an object is exported to save in the .xls format, the IDs in the cells will be changed to
zeros by the Microsoft(R) Excel application if an Id is more than 15 digits long.
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Creating An Ad Hoc Chart Report

Scenario for Ad-Hoc chart report: As a ticket administrator at Guard First, you will monitor the progress of tickets created by stakeholders of ongoing
assessments. As part of your responsibilities, you are given a task to produce a chart report that shows the number of tickets owned by stakeholders.
To meet this report objective, you will need to use the 'Tickets (Detail)' predefined domain.

The rest of this section describes the procedural steps to create a chart report using the 'Tickets (Detail)' domain.

To create a chart report:
1. Go to Analytics > Analytics and Reporting to launch the JasperReports Server.

2. On the Create menu, click Ad Hoc View.

3. The Data Chooser page appears. Click Domains, locate the 'Tickets (Detail)' domain, and select it. After selecting the domain, click Choose
Data.

4. The Data Chooser options appear with the Fields tab selected. On the Fields tab, expand the 'aglssd_ticket' table in the Selected Fields pane,
Ctrl-click the Owner, Progress, Status, Ticket Type, and 'Title fields, and click > at the top between the source and selected fields pane to move
the fields to the Selected fields box. Click < arrow to remove the selection.

5. Click the Save as Topic tab to save the topic for later use. Enter 'GF_TicketsByOwner' in the Name (required)field. Optionally enter description
in the Descriptionfield, and click Browse to choose a location in the repository for the topic. By default, the topic will be saved to
the  \adhoc\topics  location in the repository.

6. After specifying the required details on all tabs, click Chart.

7. The Ad Hoc Editor appears. In the Fields pane, drag the OWNERfield in the Group layout, and drag the TITLEfield in the column layout. After
you drag the fields, a 3D Bar chart is created by default. The unformatted 3D Bar chart appears as:
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8. Click the  icon and choose Save Ad Hoc View and Create Report. In the Save Ad Hoc View and Create Report dialog, enter
'GF_TicketsByOwner' in the Data View (required)field and enter a name in Report Name (required)field
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Formatting The Appearance Of Chart Report

You will learn now how to format the 'GF_TicketsByOwner' data view. By default, the chart report represents the data using a 3D bar chart. You will
be shown how to convert the bar chart to other forms of charts, such as Pie and Line.

The rest of this section will help you understand how to format the 'GF_TicketsByOwner' bar chart view.

To format the bar chart:
1. Optional. To open the data view,

1. In the JasperReports Server, go to View > Search Results. In the Search field, enter the data view name, and click the search icon. The
Search results appear, displaying reports and data views that match the search criteria.

Or

If you know the location of report in the repository, go to View > Repository menu.

2. After you locate the ad hoc view, click the view, or right-click the report, and choose Open in the context menu.

2. At the top of bar chart, click the text Click to add a title and enter the title as 'Tickets By Owners.'

3. In the Measures layout band, right-click the 'TITLE field, and choose Edit Legend Label in the context menu. Enter 'Tickets' in the Label field,
and click Submit.

4. Optional. To add or remove fields:
In the Measures or Group layout band, click X next to a field to remove the fields.

Right-click a field, choose Add as Measure in the context menu to add a field to the Measure layout band, or choose Replace Group in
the context menu to replace the group in the Group layout band.

Right-click in the chart area, and choose Remove Group in the context menu.

5. By default, measure and group labels and legend are displayed in the chart area. To hide labels and legend, right-click in the chart area, mouse
over the Legend and Labels in the context menu, and choose one of the options: Measures Title, Group Title, or Legend.

6. Right-click in the chart area, mouse over the Display Options in the context menu, and choose Fill Background to apply the background color
for the chart.

7. Go to the right bottom in the chart area, and when the icon appears, left-click the icon, and drag the mouse to resize the chart area.
After you finish formatting, the 3D Bar chart appears as:

8. Right-click in the chart area, mouse over the Display Options in the context menu, and choose Flat Bars. The Flat Bar chart appears as:
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9. Now, drag the TICKET_TYPEfield in the Measures layout band. Right-click the TICKET_TYPEfield, mouse hover the Change Summary
Function in the context menu, and choose Distinct Count. The Simple Series 3D Bar chart appears as:

10. Right-click in the chart area, mouse hover the Display Options in the context menu, and choose Stacked Series. The Stacked Series 3D Bar
chart appears as:

11. Right-click in the chart area, mouse over the Display Options in the context menu, and choose Horizontal Bars. The Horizontal 3D Bar chart
appears as:
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12. Now, drag the STAGE field in the Group layout band to replace the OWNERfield, and click X next to TICKET_TYPEto remove the field.

13. Right-click in the chart area, mouse over the Display Options in the context menu, and choose Horizontal Bars. The Horizontal 3D Bar chart
appears as:

14. Right-click the chart, mouse hover the Change Chart Type in the context menu, and choose Pie. The Pie chart appears as:
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15. Click  and choose Save Report to save the report. Choose Save Report As... to save the report separately for each chart type.
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Creating An Ad Hoc Crosstab Report

Scenario: As an Application Security Specialist at Guard First, you are given the task of creating a crosstab report that shows the list of entities affected
by number of the vulnerabilities grouped by vulnerability severity. To meet this report objective, you must use the Vulnerabilities (Instances)' domain.

The rest of this section provides the procedural steps that describes how to create a crosstab report using the 'Vulnerabilities (Instances)' domain.

To create a crosstab report:
1. Perform the following steps:

Go to Analytics > Analytics and Reporting to launch the JasperReports Server.

On the Create menu, click Ad Hoc View.

The Data Chooser: Source dialog appears. Click Topics, locate and select the GF_Vulnerabilities_Data topic, and click Crosstab. The
GF_Vulnerabilities_Data topic was saved while creating the 'VulnerabilitiesfromScanners' ad hoc table report. You are using this topic
because the fields available in the 'GF_Vulnerabilities_Data' topic are sufficient to meet the crosstab report scenario.

Click the  icon, choose Save Ad Hoc View As..., and enter 'ListofAffectedEntities' in the Data View Name (required)field.
Choose a folder in the repository where you want to save the report and click Save to save the report. The data view is saved as
'ListofAffectedEntities.'

2. OR

After you finish creating and formatting the 'VulnerabilitiesfromScanners' data view, save the report and data view before you start
creating a crosstab report.

Click the  icon and choose Save Ad Hoc View and Create Report. In the Save Ad Hoc View and Create Report dialog,
enter 'ListofAffectedEntities' in the Data View (required)field and enter a name in Report Name (required)field. Choose a folder in the
repository where you want to save the report and click Save to save the report. The data view and report is saved.

Click Crosstab to change the report layout and remove the fields present in the Columns and Group layout band.

3. In the Ad Hoc Editor, go to the Fields pane, expand the 'Vulnerability' table, and drag the Default Severityfield to the Rows layout. Now,
expand the 'Entity' table, drag the Nameand Entity Typefields in the Rows layout.

4. Go to the 'Vulnerability' table, right-click the Titlefield, and choose Use as Measure in the context menu. The Titlefield is added to the Measures
pane.

5. Go to the Measures pane and drag theTitlefield in the Columns layout band.

6. The unformatted crosstab report appears as:

150



151



Formatting The Appearance Of Crosstab Report

This section will help you understand how to format the 'ListofAffectedEntities' crosstab report.

To format the crosstab report:
1. Optional. To open the report:

1. In the JasperReports Server, go to View > Search Results menu. In the Search field, enter the view name, and click the search icon. The
Search results appear, displaying the reports and views that match the search criteria.

Or

If you know the location of view in the repository, go to View > Repository.

2. After you locate the ad hoc view, click the view, or right-click the report, and choose Open in the context menu.

2. At the top of the crosstab report, click the text Click to add a title, and enter the title as 'List of entities affected by number of vulnerabilities
grouped by severity.'

3. By default, the data associated with the rows and columns are hidden. To make the data visible, right-click the Name field in the table, and
choose Expand Members in the context menu. Similarly, expand the Entity Type and Default Severity fields in the crosstab report.

4. By default, the row and column summary is added to the crosstab report. You can add or delete the row and column summary to add more
meaning to the report. Right-click the Entity Type field in the table and choose Delete Row Summary in the context menu to remove the
summary at the end of each entity type.

5. After formatting, the 'ListofAffectedEntities' report appears as:
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Adding A Filter In The Crosstab Report

You can filter the values to meet the report objective or to make the data available that is only relevant to you. For filtering the data, you must create a
filter using a field.

The rest of this section helps you how to filter the severity in the 'ListofAffectedEntities' crosstab view.

To add a filter in the report:
1. In the fields pane, right-click the Default Severity field, and then choose Create Filter in the context menu. The filter with all the values

selected is created at the right side of the crosstab report in the Ad-Hoc editor.

2. For example, as an Application Security Specialist, you may want to know only those vulnerabilities that has 'High' severity. In this case, you
must filter the severity values: 'NULL,' 'Medium,' and 'Low,' and select 'High' severity.

In the Default Severity filter scroll box, select the 'High' value, or mouse hover the  icon next to stage filter, choose Show
Operator, and select equals and High in the drop-down boxes.

3. After applying the filter, the crosstab report appears as:

4. Optional. You can even filter to include or exclude certain values in the cross tab report. For example, if an entity has two vulnerabilities with
low and medium severities, you can choose to retain the entity showing a vulnerability with only low severity. To apply this type of filter,
right-click the 'Medium' severity value in the entity row, and choose Exclude in the context menu. After applying the filter, that particular entity
will show the number of vulnerabilities with low severity only.
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Viewing And Running A Report In The Ad Hoc Editor

When you finish creating a report or if you add or remove any details while formatting a report, you may want to know how a report output appears
using a particular output format.

To view and run a report in the editor:

At the top of Layout band, click  to view a report in the display mode. The report will be displayed in the editor, disabling all the options

to view a report in the display mode. The report will be displayed in the editor, disabling all the options. Click the  icon again to continue
working in the editor.

At the top of Layout band, Click . The JasperReports Server opens a tabbed browser to execute the report. Depending on the size of the
data, allow sufficient time for the JasperReports Server to display the report.

After a report is displayed, mouse hover the Export option, and choose an appropriate format to view how the a report appears in that format.

The filters applied to a user role in RiskVision are rendered when running a report in JasperReports Server. On the other hand, the filters are not
rendered in case of SQL-based reports that are imported into JasperReports Server from iReport Designer Professional application.
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Scheduling a Report in JasperReports Server

The report scheduler in JasperReports Server allows you to schedule predefined reports as well as the custom built reports. A custom report can be
scheduled, only if you are the owner of that report or any user for whom you have assigned the permission to schedule a report.
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Scheduling a Report

Scenario: As a program owner at Guard First, you are given a task to schedule the Program Assessment Details daily to email the 'GF_Audit_Risk'
report to the compliance team in your organization.

The rest of this section will help you understand how to schedule the Program Assessment Details report, which will provide the assessment details of
the 'GF_Risk_Audit' program.

To schedule a report:
1. Go to Analytics > Analytics and Reporting to launch the JasperReports Server.

2. To search a report that you want to schedule, do one of the following:
1. Go to View > Repository, expand the Reports folder that is present in the Public folder, and select the Program folder to display the list

of reports.

2. Go to View > Search Results, enter text in the Repository text box, and click Search to return the search results. You can also use the
predefined filters to narrow the search criteria in finding the desired report.

3. After you find the Program Assessment Details report, right-click in the report row, select Schedule... in the context menu to display the
Scheduled Jobs page, and click  Create Schedule.

4. The New Schedule page appears, displaying the Schedule tab.
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Specify the following fields:

Schedule Start

Choose the type of start job. If you choose Immediately, the report runs after you the submit the job. To start the job at a later date,
choose On, and click the calendar icon to select a date. Retain the default selection.

Specify in which time zone the job must be started. By default, the reports are scheduled in the Pacific Standard Time. Retain the default
selection.

Recurrence

Choose None, Simple or Calendar. If you choose None, the job is run only once based on the start job settings. If you choose Simple,
then you must specify Repeat every, and choose Indefinitely, Times, or Until. Because your objective is to run the job daily for 30 days,
you must enter 1 in the box next to Repeat every, and choose days from the drop-down list. Choose Until and click the calendar icon to
select a date that is 30 days from the current date.

5. Click the Parameters tab. Select the values for input control that you want the job to use when producing the report results. Select the
'GF_Risk_Audit' program in the Programlook-up field.

6. Click the Output Options tab.
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Specify the following fields:

Base Output File Name. Enter 'GF_Risk_Audit_Job' for displaying the output of the job. 

Output Description. Specify the description for the job output.

Time Zone. Select the desired time zone.

Output Locale. Select the locale settings for the report. Retain this setting to 'Default.'

Formats. Choose one or more output formats. By default, the scheduler uses the PDF format. When you choose more than one format, each
format is stored as a separate file in the repository and attached as a separate file to the email notification.

File. Handling. By default, the Overwrite Filesoption is selected to overwrite the old report file name with the new ones. Check the box next to
Sequential Filenames and enter the timestamp pattern. You may use this option in case of recurring jobs to know the latest report output file.
The default timestamp pattern is 'yyyyMMddHHmm.' 

Output Destination. By default, the Output To Repositoryoption is selected to save the output file to the repository. Click Browse if you have
to change the output location in the repository. Check the box next to the Output to Host File System if you have to publish the output to the
file hosting services. Check the box next to Output To FTP Serverif you have upload the files to the FTP server.

Notifications. Enter email addresses to send notifications when scheduler runs and job is executed. Enter messages upon successful and/or
failure notifications. Multiple email addresses must be separated by commas in the To box. Include reports as repository links, attachments, ZIP
format, or HTML.

Click Save.

The Save As dialog appears. Enter Schedule Job Name (required)and Scheduled Job Description.

Click Save. The report is scheduled.
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Modifying A Scheduled Job

JasperReports Server allows you to modify or delete a job if you have sufficient permissions for the scheduled report. After you submit the schedule
job, the job appears on the Scheduled Jobs page of the report that you have scheduled.

To modify a scheduled job:
1. Locate the scheduled report in the repository, right-click in the row, and choose Schedule in the context menu. A scheduled report will have

the icon at the beginning of the report row.

2. The Scheduled Jobs page appears for the chosen report. To modify the report, click the Edit link in the job row, and make changes on the
Schedule, Parameters, Output Options, and Notifications tabs.

To stop the recurring job, delete it.

 To delete a scheduled job: 
1. Locate the scheduled report in the repository, right-click in the row, and choose Schedule in the context menu. A scheduled report will have

the  icon at the beginning of the report row.

2. The Scheduled Jobs page appears for the chosen report. To stop the job, click the Delete link in the job row. The job is deleted without any
confirmation.
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Converting RiskVision Charts To JasperReports Server

Before you can convert your RiskVision chart, ensure that you are using at least a 6.5 version of RiskVision and have installed the RiskVision Report
Server. Converting RiskVision charts to JasperReports Server is a two step procedure:

1. Exporting RiskVision charts

2. Importing RiskVision Charts into JasperReports Server

In RiskVision application, you can convert charts saved in the "My Charts" and "Shared Charts" folder. When you save a chart to the JRXML file
definition, you can create a report in any folder of a repository for which you have the appropriate permission. The Jasper Export action does not
convert all the chart features. Converted complex features and chart types are modified or removed in JasperReports Server. Generating a flawless
chart in JasperReports Server depends on your ability to understand the complex chart features in RiskVision and the options available in Add
JasperReport wizard pages. This assists you to manually set up the features in Add JasperReport wizard to resemble the actual chart.
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Exporting Charts to the JasperReports Server

Exporting a RiskVision chart to JasperReports Server involves saving the JRXML file definition. You can import the JRXML saved file into
JasperReports Server to implement more interactive charts.

To export a chart to JasperReports Server format:
1. In the RiskVision application, go to Analytics > Charts.

2. In the charts tree, locate the group which contains the chart that you want to export and then click the group to display the available charts on
the right pane.

3. You can export charts with or without a parameter.
1. To export a chart without a parameter, select a chart and choose Export to Jasper from the More Actionsdrop-down list.

2. To export a chart along with a parameter, select a chart and then click Details. In the Charts tab, click Jasper Export.

4. A confirmation dialog appears asking you whether to save or open the JRXML file. Choose Save and then click OK to save the chart.
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Importing RiskVision Charts into the JasperReports Server

You can import a RiskVision chart saved in JRXML format. RiskVision charts can be enhanced using the additional features of JasperReports, such as
fonts, a query that restricts the report data from displaying additional details and so on.

To import a RiskVision chart:
1. Go to Analytics > Analytics and Reporting. The JasperReports Server menu appears.

2. On the View menu, click Repository.

3. Expand the folder to locate the desired group where you want to import the chart.

4. Right-click the folder and point cursor on Add Resource option to select JasperReport. The Add Resource page appears on the context menu
only if you have write permission to the folder.

5. In the Setup page that appears, enter Name, Resource ID and optional Description for the report.
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6. Locate the JRXML file by selecting Upload a Local File and then click Browse to select the appropriate file.

7. Click Controls and Resources. The JasperReports Server uploads the JRXML file to the repository and provide suggestions on missing
resources like images, input parameters, and more.

1. If the exported RiskVision chart contains input parameters, perform the following steps:

Click Add Input Control.

Choose Select an Input Control from repository and click Browse. In the Select Resource From Repository dialog, expand >
Public > Input Controls > Multi Select and select the control.

In the Select an Input Control from repository, click Select

In the Add Input Control page, click Next to continue.

In the Controls and Resources page, check the box next to the Always promptoption, which is available next to the Display
Modedrop-down list.

2. If the exported RiskVision chart contains columns to drill-down, perform the following steps:

Click Add Input Control.

Choose Define an Input Control in the next step and click Next.

In the Create Input Control page, retain the default selection "Single Value" in the Typedrop-down box.

Enter a label in the Prompt Text (required)field and Parameter Name (required)field. The value to be entered in the
Parameter Name (required)field is the name of the parameter found in the .jrxml file (exported RiskVision chart). Click Next to
continue.

In the Locate Datatypes page, Choose Define a Datatype in the next step and click Next to continue.

In the Set the Datatype Kind and Properties page, perform the following steps:

1. Retain the default selection "Text" in the Type drop-down box.

2. Specify a name for the resource in the Name (required)field and an ID for the resource in the Resource ID
(required)field. The value to be entered in the sfield is the name of the parameter found in the JRXML file (exported
RiskVision chart).

3. Click Save.

8. Click Data Sources, choose the Select data source from repository option, and click Browse. In the Select Data Source from Repository
dialog, expand the group, select  RiskVision under the Data Sources subgroup, and click Select.

9. For information about how to define a query and customizing a report, see Adding Report Units from JRXML Files in the JasperReports-
Server-User-Guide.

Click Submit to save the report. You can submit the report on any page of the Add JasperReport page.
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Conversion Settings for RiskVision Chart Options

The following list describes the RiskVision chart options and the actions you will need to perform while importing the charts into the JasperReports
Server for successful conversion.

When Allow multiple objectsoption is selected on the Filters tab of Create a Chart wizard

Solution: In the Add JasperReport wizard, click the Controls & Resources page, click Add Input Control, choose Select an Input Control from
repository, click Browse and then select input controls from Multi Select group. In the Add JasperReport wizard, click Controls & Resources
and define the Multi select input control.

When Allow multiple objectsoption is cleared on the Filters tab of Create a Chart wizard

Solution: In Add JasperReport wizard, click Controls & Resources, click Add Input Control, choose Select an Input Control from repository,
click Browse and then select input controls from Single Select group.

When parameters defined on the Advanced settings tab of Create a Chart wizard

Solution: The input control must be created using the parameter name available in the JRXML file.

Radar chart types are not supported in Jaspersoft. Hence, these charts are modified and displayed as tables in JasperReports Server.
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Converting Domain Naming Terminology into a User Friendly Name

A custom created domain in JasperReports Server uses database views and tables from the RiskVision database. Further, if you customize the
display name of an object, or if a custom attribute is added to any RiskVision object, such attributes will fail to render the display names from the user
interface of that object when you create a domain. As a result, all the attributes in a domain have names that are not easy to understand while
creating a report. In order to help you pick the correct attributes while creating an Ad-Hoc report, provides an utility that can import a resource bundle
of a particular domain to fully convert the customized attribute naming terminology into a user-friendly name. When you convert a particular
JasperReports domain, all the attribute names matches with the attributes present in RiskVision.

A domain naming terminology can be converted into a user-friendly name using a three-step procedure:

1. Exporting a Domain Resource Bundle

2. Importing a Domain Resource Bundle into RiskVision

3. Adding a New Resource Bundle

Before you start the conversion process, make sure that your RiskVision role has the Configure UI permission, and also you have the administrator
role for the JasperReports Server.
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Exporting A Domain Resource Bundle

Perform the following steps to export a domain resource bundle.

1. In the JasperReports Server application, go to View > Repository, search and select a domain, and then right-click on the domain and choose
Edit.

2. On the Edit Domain page, click the Edit with Domain designer link. By default, the Edit with Domain designer option is selected.

3. On the Domain Designer page, click Export Bundle to bring on its pop-up. Check the box next to the Auto-generate label key if missing and
Auto-generate description key if missing options, and click OK.

4. A prompt box to save or open the domain bundle properties file appears. Choose Save File, select the location to save the file, and click OK.

5. Click OK on the Domain Designer page and click Submit on the Edit Domain page to save the domain. 

168



Importing a Domain Resource Bundle Into RiskVision

Perform the following steps to import the domain resource bundle into RiskVision.

1. After you log in to the RiskVision application, click Reporting at the top right side of the page.

2. The Import Jasper Resource Bundle dialog appears. Click Browse, select the domain bundle properties file that you have saved in step 5 of
"Exporting a Domain Resource Bundle" section, and click OK.

3. A dialog appears asking you whether to save or open the resource bundle properties file. Choose Save File, select the location to save the file,
and click OK.
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Adding a New Resource Bundle

To complete the last step in the conversion process, perform the following steps to add a new resource bundle properties file.

1. Go back to the same domain that you have selected in the "Exporting a Domain Resource Bundle" section, select and right-click on the
domain, and choose Edit.

2. On the Edit Domain page, click Add Locale Bundle to bring on the pop-up, click Browse to select and upload the resource bundle properties
file, and click Select.

3. After the bundle is set, click Submit on the Edit Domain page.

Now that you have completed the conversion process, it will be now easy to pick the easy-to-understand attributes from a domain while creating a
report.
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System Logs

System logs capture any errors in JasperReports Server's code, but the logging levels can be configured to capture more information for debugging
purposes. Log files are generated in JasperReports Server using the Apache log4j package. To view these files, users must have access to the file
system where JasperReports Server is installed. 

The default log file is C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF\log/jasperserver.log and the default log
configuration file is C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF\log4j.properties. Log levels can be set
through these files, or through the UI by following the below steps.

To set the current logging levels through the UI:

1. Log in to JasperReports Server as an administrator.

2. Navigate to Manage > Server Settings.

3. Click Log Settings on the panel to the left.

4. Use the drop-down lists next to each class to change its log level.

5. Optional: If a report is taking too long to execute, change the log level of the below classes to DEBUG to capture the SQL queries to run for
reports as well as their timing:

com.jaspersoft.commons.util.JSControlledJdbcQueryExecuter: Logs the amount of time it takes one of JRJdbcQueryExecuter's
queries to return data to a report.

com.jaspersoft.commons.semantic.dsimpl.JdbcBaseDataSet: Logs SQL queries generated from queries that use a Domain.

net.sf.jasperreports.engine.query.JRJdbcQueryExecuter: Logs text and parameter values for queries run by this logger.

C h a n g i n g  t h e  l o g  l e v e l  o f  t h e  o r g . h i b e r n a t e . S Q L  c l a s s  t o  D E B U G  w i l l  g e n e r a t e  a
l a r g e  a m o u n t  o f  l o g g i n g  t h a t  c o u l d  n e g a t i v e l y  i m p a c t  J a s p e r R e p o r t s  S e r v e r ' s
p e r f o r m a n c e .

Further information on system logs and how to use them can be found on the Jaspersoft Community page.

The Log Settings page.
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Log Collectors

While system logs are useful for finding problems with JasperReports Server, the size of the log files can make it difficult to find the log messages
associated with a specific problem. Additionally, viewing these files requires access to the server's file system. Log collectors simplify all of this by
recording logs from a specific user or report for a specified duration. These logs can be made available through JasperReports Server's user interface
by administrators.

To create, start, stop, download, or delete a log collector:

1. Log in to JasperReports Server as an administrator.

2. Navigate to Manage > Server Settings.

3. Click Log Collectors on the panel to the left.

4. Click the Create Log Collector button to open the New Log Collector page.

The Log Collectors page.
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5. Enter a name for the collector in the Collector Name field.

6. Type a user ID in the User ID field to display logs related to only that user. Leave the field empty to include all logs.

7. For a new log collector, the resource URI must be an existing report or ad hoc view from the repository. Click Browse under the Resource
URI field to select one. 

8. Optional: If you have data snapshots enabled, check the box next to Include data snapshot to include data from the snapshot in the log file.

9. Use the Verbosity Level dropdown to choose a verbosity level of low, medium or high. Low is selected by default.

10. Click Save to create the new log collector and add it to the Log Collectors page. A log collector starts as soon as it is created.  

11. To stop a log collector, click the  icon to the right of the collector. Alternatively, click Stop All to stop all log collectors.

O n c e  a  l o g  c o l l e c t o r  h a s  b e e n  s t o p p e d ,  i t  c a n n o t  b e  r e s t a r t e d .  T h e  c o l l e c t o r  m u s t  b e
d e l e t e d  a n d  c r e a t e d  a g a i n .

The New Log Collector page.

The Log Collectors page with log collectors added to it.
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12. To download a log collector's log file, click the  icon to the right of the collector. Log collectors are saved as .zip files containing .log files.

13. To delete a log collector, click the  icon to the right of the collector. Alternatively, click Delete All to delete all log collectors. 

174



Auditing & Monitoring Events

While system logs capture messages from the internal code of JasperReport Server, the auditing and monitoring systems capture user events that
give a larger picture of how users interact with JasperReport Server and what resources they use. 

Auditing stores key events that are of interest to administrators. Events that have been audited can be saved and automatically moved to an archive
after a specified duration.

Monitoring is based on audited events and generates reports that contain such metrics as which reports use the most resources. This helps with
optimizing data sources, domains, and reports.

The events captured by auditing and monitoring include:

Running a report or subreport;

Creating, deleting, or updating a report schedule; and

Running a scheduled report

The full specification of events can be viewed in the configuration file located at C:\ReportServer\ReportServer\apache-
tomcat\webapps\jasperserver-pro\WEB-INF\applicationContext-audit.xml. By default, the auditing and monitoring subsystems are disabled.

To enable auditing and monitoring:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the js.config.properties file.

3. Ensure the following properties are enabled in the following order:

feature.audit_monitoring.enabled

audit.records.enabled

monitoring.records.enabled

To set the audit data's interval level:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the applicationContext-audit.xml file.

3. Under auditService , set the following properties as desired:

maxAuditEventAge : how many days before data is deleted (set to 0 by default, meaning data is never deleted).

maxAuditEventAgeToArchive : how many days before data is moved to the archive (set to 30 by default).

To view the audit data:

1. Locate the audit data in the /Public/Audit folder of the repository. 

2. Slow running reports can be identified by consulting the following: 

Performance Report

Performance Crosstab Report: Shows the query executing time along with report execution and rendering time.

To view the monitoring data:

1. Locate the monitoring data in the /Public/Monitoring folder of the repository.

2. Diagnose the performance and resource utilization of reports using the following:

Report Monitoring Resources Report: Provides a list of all reports and shows their average and high-low execution times.
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Report Monitoring Details Report: A crosstab that shows report execution times on one axis and dimensions such as time hierarchy,
user and organization, and event type on the other.
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Real-Time Diagnostics

While the auditing and monitoring systems provide a historical record of events that occur within JasperReports Server, diagnostics provide
administrators with the overall health of JasperReports Server and its Java Virtual Machine. For example, diagnostics can provide information such as
memory use, login and logout times, concurrently running reports, and number of scheduled reports.

Diagnostic data is available to administrators in the Public > Diagnostic folder of the JasperReports Server UI. The configuration file can also be
accessed and edited using the steps below. The file consists of object-encapsulating classes known as beans, and excluding these beans from the
code can help narrow down the diagnostic results.

To limit the diagnostic results:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the applicationContext-diagnostic.xml file.

3. To exclude an attribute:

a. Locate the managed bean where the desired attribute is defined.

b. Uncomment the attribute from the excludedDiagnosticAttributes  property.

4. To exclude an entire bean: 

a. Locate the desired bean.

b. Comment the bean or remove it from the list of beans in the diagnosticExportingMBeansMap .

5. To disable real-time diagnostics entirely, rename or remove the following files:

applicationContext-diagnostic.xml

applicationContext-diagnostic-pro.xml
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Running out of Database Connections

JasperReports Server manages a pool of connections for each Java Database Connectivity (JDBC) data source. By default, twenty connections are
provided. If many reports are being run concurrently against a single data source, the connection limit may be reached which can cause a slowdown
in service.

The pool of connections has a limited size to prevent having too much memory being permanently allocated to connections. However, users who
need more concurrent connections on a regular basis can increase the limit.

To increase the amount of connections:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the applicationContext.xml file.

3. Change the constructor argument number of the dataSourceObjectPoolFactory  bean to the desired amount. The optimal amount
varies depending on the setup and number of users in the system. Experimentation is encouraged.
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Concurrent Users Vs. Concurrent Report Executions

The load on JasperReports Server can be increased by user actions such as executing reports, exploring data through ad hoc views, and executing
automated reports through APIs or scheduling.

As a general rule, the ratio of named users to active users to concurrent actions can be estimated using the 100:10:1 rule. By using this rule, users
can more effectively schedule automated reports so that too much strain is not placed on the system. Scheduled reports can be executed with the
Snapshot option enabled to ensure that these reports do not impose any resource requirements at the time of viewing. The Snapshot option stores a
copy of data when the report first runs so that users can get data from that copy rather than taking up memory querying the data source. This
especially reduces the load for large reports or reports that are frequently viewed.

To enable the Snapshot option:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF\.

2. Open the applicationContext-data-snapshots.xml file.

3. Locate the dataSnapshotService  bean.

4. Set the snapshotPersistenceEnabled  property to true.
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Measuring & Tuning Ad Hoc Performance

If JasperReports Server is running slower than expected, then it is possible that a bottleneck exists in one of the server's ad hoc reports. In this case,
JasperReports Server offers tools to measure and tune ad hoc performance.

To measure ad hoc performance:

1. Log in to JasperReports Server as an administrator.

2. Navigate to Manage > Ad Hoc Cache. There will be two columns that measure the performance of ad hoc reports.

Query (msec): The time between when the query was sent to the database and when the first row was received. If this time seems
abnormally slow, better indexing may be required.

Fetch (msec): The time between when the first and last rows were received. If this time seems abnormally slow, then there may be a
network bottleneck. This is true for any server architecture.

3. Optional: If the Fetch column indicates a network bottleneck:

a. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF\classes.

b.  Open the jasperreports.properties file. 

c. Adjust the number of the net.sf.jasperreports.jdbc.fetch.size=n  property as desired. Note that n represents the
number of rows to fetch at one time.

To tune ad hoc performance:
1. Log in to JasperReports Server as an administrator.

2. Navigate to Manage > Ad Hoc Settings.

3. Tune one or both of the following properties under Query Limits as needed:

Ad Hoc Dataset Row Limit: The maximum number of rows that an ad hoc report can return. Once the limit is reached, JRS truncates
the report. Reducing the number of reported rows may improve performance, but reports may not accurately reflect the data set as a
result.

Ad Hoc Filter List of Values Row Limit: The maximum number of items displayed in the Condition Editor when a user defines filters
for a domain-based ad hoc report. Setting this to a lower value can improve performance. 
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Large Reports

In order to avoid running out of memory, JasperReports Server uses the JRFileVirtualizer to handle reports with a large page count. This virtualizer
creates a separate file for every page of the report after page 300. While this does reduce strain on the Java memory heap, it can also potentially slow
down JasperReports Server. If it appears that larger reports are causing memory bottleneck issues, it is possible to adjust the virtualizer's settings.

To edit the maximum report size:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the applicationContext.xml file.

3. Locate the fileVirtualizerFactory  bean.

4. Adjust the maxSize  attribute as desired.

M a k i n g  t h e  v a l u e  f o r  m a x S i z e  a b n o r m a l l y  h i g h  w i l l  e f f e c t i v e l y  d i s a b l e  t h e  v i r t u a l i z e r ,
b u t  m a y  c a u s e  m e m o r y  p r o b l e m s .
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Disable Multi-Line Data Processing

By disabling multi-line data processing, report generation for all reports will speed up by 2-4 times. While this will cause no ill effects for reports with
single-line tabular data, reports with multi-line data will not display information beyond the first line in each row.

To disable multi-line data processing:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF\classes.

2. Open the jasperreports.properties file.

3. Locate the net.sf.jasperreports.text.measurer.factory  parameter.

4. Change its value from net.sf.jasperreports.engine.util.JdkGlyphFixTextMeasurerFactory  to
com.jaspersoft.jasperserver.api.engine.jasperreports.util.SingleLineTextMeasurerFactory .
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Modify the Caching Values

If the data in JasperReports Server is not updating constantly, the caching values may need to be modified. Different settings may cause different
effects depending on the scenario so experimentation is encouraged.

To adjust the caching settings:

1. Navigate to C:\ReportServer\ReportServer\apache-tomcat\webapps\jasperserver-pro\WEB-INF.

2. Open the applicationContext-adhoc.xml file. 

3. Locate the dataSetCache  bean.

4. Adjust either or both of the following parameters as desired:

defaultTimeoutMinutes : The number of minutes the system will wait before removing a dataset from the cache. Ensures that
stale data is periodically refreshed. Set to 60 by default.

DefaultUnusedTimeoutMinutes : The number of minutes the system will wait before removing a used dataset from the cache.
Set to 20 by default. 
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About Jaspersoft Studio Professional

Jaspersoft Studio is an Eclipse-based report designer for JasperReports Library and JasperReports Server; it's available as an Eclipse plug-in or as a
stand-alone application. Jaspersoft Studio allows you to create sophisticated layouts containing charts, images, subreports, crosstabs, and more. You
can access your data through a variety of sources including JDBC, TableModels, JavaBeans, XML, Hibernate, Big Data (such as Hive), CSV, XML/A, as
well as custom sources, then publish your reports as PDF, RTF, XML, XLS, CSV, HTML, XHTML, text, DOCX, or OpenOffice.

TIBCO JasperReports(R) Server builds on TIBCO JasperReports(R) Library as a comprehensive family of Business Intelligence (BI) products, providing
robust static and interactive reporting, report server, and data analysis capabilities. These capabilities are available as either stand-alone products, or
as part of an integrated end-to-end BI suite utilizing common metadata and provide shared services, such as security, a repository, and scheduling.
The server exposes comprehensive public interfaces enabling seamless integration with other applications and the capability to easily add custom
functionality.

The heart of the TIBCO Jaspersoft(R) BI Suite is the server, which provides the ability to:

Easily create new reports based on views designed in an intuitive, web-based, drag and drop Ad Hoc Editor.

Efficiently and securely manage many reports.

Interact with reports, including sorting, changing formatting, entering parameters, and drilling on data.

Schedule reports for distribution through email and storage in the repository.

Arrange reports and web content to create appealing, data-rich Jaspersoft Dashboards that quickly convey business trends.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be created outside of the server. You can either use Jaspersoft(R)
Studio or manually write JRXML code to create a report that can be run in the server.
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Appendix Topics

The Topics available in Jasper domain are mentioned below:

Assessments Basic Details

Data Feeds Basic Details

Entities Basic Details

Exceptions Basic details

Findings Basic Details

Incidents Basic Details

Programs Basic Details

Threats Basic Details

Tickets Basic Details

Vulnerability Basic Details(Definition)

Vulnerability(Instance) Basic Details
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Assessment Domain Part 1 of 2

 View  Fields  Measures

Assessments Archived Compliance Score

Assessment
Owner

Current Risk Score

Assessment
Ownership Type

Inherent Risk Score

Create Date Progress

Current Status Residual Risk Score

Due Date Simple Risk Score

End Date

Is Not Closed

Name

Version

Assessment Control Results Answered By Choice Score

Choice Text Compliance Level

Comments Risk Score

Compliance
Overwrite
Comment

Implementation

Description

Help Text

Control Title

Question Text

Remediation

Survey Status
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Survey
Workflow
Status

Time

Assessment Compliance Score Control Name Compliance Score

Entity Name Simple Risk Score

Name

Program Name

Assessment Compliance Score by Dynamic
Group

Control Name Compliance Score

Dynamic Group
Name

Simple Risk Score

Entity Name

Name

Program Name

Assessment Compliance Score by Dynamic
Group(History)

Control Name Compliance Score

Dynamic Group
Name

Simple Risk Score

Entity Name

Name

Program Name

Updated On

Assessment Compliance Score(History) Control Name Compliance Score

Entity Name Simple Risk Score

Name

Program Name

Updated On

 View  Fields  Measures
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Assessment Current Stage Owner

Stage Name

Assessments Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom
Encrypted String
1

Custom Rational Number 1

Custom
Encrypted String
2

Custom Rational Number 2

Custom
Encrypted String
3

Custom
Encrypted String
4

Custom
Encrypted String
5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

 View  Fields  Measures
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Custom String 7

Custom String 8

Custom String 9

Custom String
10

Custom String
11

Custom String
12

Custom String
13

Custom String
14

Custom String
15

Custom String
16

Custom String
17

Custom String
18

Custom String
19

Custom String
20

Custom String
21

Custom String
22

Custom String
23

Custom String
24

 View  Fields  Measures
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Custom String
25

Custom Text 1

Custom Text 2

Assessments Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom
Encrypted String
6

Custom Rational Number 3

Custom
Encrypted String
7

Custom Rational Number 4

Custom
Encrypted String
8

Custom
Encrypted String
9

Custom
Encrypted String
10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String
26

Custom String
27

Custom String
28

Custom String

 View  Fields  Measures
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29

Custom String
30

Custom String
31

Custom String
32

Custom String
33

Custom String
34

Custom String
35

Custom String
36

Custom String
37

Custom String
38

Custom String
39

Custom String
40

Custom String
41

Custom String
42

Custom String
43

Custom String
44

Custom String
45

Custom String
46

Custom String

 View  Fields  Measures
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47

Custom String
48

Custom String
49

Custom String
50

Custom Text 3

Custom Text 4

Assessments Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom
Encrypted String
11

Custom Rational Number 5

Custom
Encrypted String
12

Custom Rational Number 6

Custom
Encrypted String
13

Custom
Encrypted String
14

Custom
Encrypted String
15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String
51

 View  Fields  Measures
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Custom String
52

Custom String
53

Custom String
54

Custom String
55

Custom String
56

Custom String
57

Custom String
58

Custom String
59

Custom String
60

Custom String
61

Custom String
62

Custom String
63

Custom String
64

Custom String
65

Custom String
66

Custom String
67

Custom String
68

Custom String
69

 View  Fields  Measures
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Custom String
70

Custom String
71

Custom String
72

Custom String
73

Custom String
74

Custom String
75

Custom Text 5

Custom Text 6

Assessments Workflow Details Assessment
Questionnaire

Assessment
Questionnaire
Owners

Assessment
Stage Name

Assessment
Workflow
Stakeholders

Since Date

Assessments Workflow Histories Assessment
Workflow
Histroy
Comment

Assessment
Workflow
History Date

Assessment
Workflow
Histroy Owner

Assessment
Workflow
Histroy Stage

 View  Fields  Measures
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Assessment
Workflow
Histroy Target
User

Assessment
Workflow
Histroy To Stage

Control Path Control Path

Entities Created By Accountability Impact

Creation Time Annual Maintenance

Data Source(s) Availability Impact

Discovery
Method

Availability Impact Cost Hours

Entity
Description

Average Remediation Time Days

Entity Name Business Value

Entity Subtype Business Value Hours

Entity Type Confidentiality Impact Cost Per Database

First Seen Date Confidentiality Impact Cost Per Record

Installation Date Confidentiality Impact

Maintenance
Date

Criticality

Maintenance
Reference

Data Integrity Cost

Manufacturer Hardware Replacement Cost

Model Integrity Impact

Organization
Name

Number Of Users

Product Name Operating Budget

Security
Classification

Single User Availability Cost

 View  Fields  Measures
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Status Software Replacement Cost

Serial Number

Version Status

Warranty
Expiration Date

Warranty
Reference

Entities Hierarchy Hierarchy
Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Assessment Exceptions Control Override Compliance Score

 View  Fields  Measures

196



Current
Workflow Stage
Name

Status

Exception Name

Exception
Number

Expiration

Next Review

Program

Reason For
Exception

Recurrence End
Date

Recurrence
Start Date

Requested By

Risk

Status

Start

Status Modified
By

Survey Evidences Content Type Version

Description

Document
Caption

Name

URL

When Uploaded

Uploaded By

 View  Fields  Measures
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Likelihood And Impact Impact Caption
1

Impact Floor Score 1

Impact Caption
2

Impact Floor Score 2

Impact Caption
3

Impact Floor Score 3

Impact Caption
4

Impact Floor Score 4

Impact Caption
5

Impact Floor Score 5

Impact Caption
6

Impact Floor Score 6

Impact Caption
7

Impact Floor Score 7

Impact Caption
8

Impact Floor Score 8

Impact Caption
9

Impact Floor Score 9

Impact Caption
10

Impact Floor Score 10

Likelihood
Caption 1

Likelihood Floor Score 1

Likelihood
Caption 2

Likelihood Floor Score 2

Likelihood
Caption 3

Likelihood Floor Score 3

Likelihood
Caption 4

Likelihood Floor Score 4

Likelihood
Caption 5

Likelihood Floor Score 5

Likelihood
Caption 6

Likelihood Floor Score 6

Likelihood
Caption 7

Likelihood Floor Score 7

Likelihood
Caption 8

Likelihood Floor Score 8

 View  Fields  Measures
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Likelihood
caption 9

Likelihood Floor Score 9

Likelihood
Caption 10

Likelihood Floor Score 10

Overall Impact
Caption

Overall Impact Floor Score

Overall
Likelihood
Caption

Overall Likelihood Floor Score

Impact Score 1

Impact Score 2

Impact Score 3

Impact Score 4

Impact Score 5

Impact Score 6

Impact Score 7

Impact Score 8

Impact Score 9

Impact Score 10

Likelihood Score 1

Likelihood Score 2

Likelihood Score 3

Likelihood Score 4

Likelihood Score 5

Likelihood Score 6

Likelihood Score 7

Likelihood Score 8

 View  Fields  Measures
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Likelihood Score 9

Likelihood Score 10

Overall Impact Score

Overall Likelihood Score

Programs Program
Description

Assessment Duration

Program Name

Program Owner

Program Type

Recurrence

Team

Workflow Name

Assessment Responses Action Implementation Cost

Comment Override Compliance Score

End Date Time To Implement

Mitigation
Status

Owning
Organization

Response Title

Start Date

Assessments Response Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom
Encrypted String
1

Custom Rational Number 1

 View  Fields  Measures
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Custom
Encrypted String
2

Custom Rational Number 2

Custom
Encrypted String
3

Custom
Encrypted String
4

Custom
Encrypted String
5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String
10

Custom String
11

Custom String
12

 View  Fields  Measures
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Custom String
13

Custom String
14

Custom String
15

Custom String
16

Custom String
17

Custom String
18

Custom String
19

Custom String
20

Custom String
21

Custom String
22

Custom String
23

Custom String
24

Custom String
25

Custom Text 1

Custom Text 2

Assessments Response Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom
Encrypted String
6

Custom Rational Number 3

 View  Fields  Measures
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Custom
Encrypted String
7

Custom Rational Number 4

Custom
Encrypted String
8

Custom
Encrypted String
9

Custom
Encrypted String
10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String
26

Custom String
27

Custom String
28

Custom String
29

Custom String
30

Custom String
31

Custom String
32

Custom String
33

Custom String
34

 View  Fields  Measures
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Custom String
35

Custom String
36

Custom String
37

Custom String
38

Custom String
39

Custom String
40

Custom String
41

Custom String
42

Custom String
43

Custom String
44

Custom String
45

Custom String
46

Custom String
47

Custom String
48

Custom String
49

Custom String
50

Custom Text 3

Custom Text 4

Assessments Response Custom Attributes 3 Custom Date 7 Custom Number 7

 View  Fields  Measures
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Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom
Encrypted String
11

Custom Rational Number 5

Custom
Encrypted String
12

Custom Rational Number 6

Custom
Encrypted String
13

Custom
Encrypted String
14

Custom
Encrypted String
15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String
51

Custom String
52

Custom String
53

Custom String
54

Custom String
55

Custom String
56

Custom String
57

 View  Fields  Measures
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Custom String
58

Custom String
59

Custom String
60

Custom String
61

Custom String
62

Custom String
63

Custom String
64

Custom String
65

Custom String
66

Custom String
67

Custom String
68

Custom String
69

Custom String
70

Custom String
71

Custom String
72

Custom String
73

Custom String
74

Custom String
75

 View  Fields  Measures
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Custom Text 5

Custom Text 6

Assessment Tickets Disposition Percent Complete

End

Exception
Expiration Date

Owner

Owner First
Name

Owner Last
Name

Owner Middle
Name

Planned End

Planned Start

Priority

Start

Status

Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

Assessment Findings Control

Finding Created
By

Finding Created
On

 View  Fields  Measures
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Finding Current
Stage

Finding
Description

Entity

Finding Title

Finding Status

Finding Team

Impact

Individual

Finding Last
Modified By

Finding Last
Modified Date

Likelihood

Residual
Likelihood

Residual Impact

Residual Risk
Score

Inherent Risk
Score

Assessment Compensating Controls Compensating
Control
Statement

Compensating
Control Title

Created By

Last Update
Time

Subcontrol

 View  Fields  Measures

208



AlwaysOn Assessment Compensating Controls Compensating
Control
Statement

Compensating
Control Title

Created By

Last Update
Time

Subcontrol

AlwaysOn Assessment Compensating Controls Created By

Name

Title

Upate Time

Value

AlwayOn Assessment Exception Request Last Update
Time

Risk

Exception ID Workflow Stage

End Time

Name

Start Time

Stage

Status Modified
By

Subcontrol

AlwaysOn Assessment Finding Asset Name Custom Long 1

Program Name Custom Long 2

Control
Statement

Risk Score

 View  Fields  Measures
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Created Date

Custom Flag 1

Custom Flag 2

Custom Date 1

Custom Date 2

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String
10

Custom Text 1

Custom Text 2

Description

Impact

Last Updated

Likelihood

Status

Owner

 View  Fields  Measures
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Title

Team

AlwaysOn Assessment Responses Action Owner

Action Type

Mitigation
Status

Mitigation
Comment

Subcontrol

Title

AlwaysOn Assessment Tickets Created Time Percent Complete

Description Risk Level

Identifier Stage

Name

Owner Name

Status

Updated Time

Control Groups Control Group
Name

Compliance
Score

% Answered

Risk Score

 View  Fields  Measures

Note: 

Control Group Name will show the lowest-level Control Group, Control Objectives (if applicable), and Controls. 

The Compliance Score of the lowest level Control Group is the average of the Compliance Scores of the Controls in the Group.

The % Answered of the lowest level Control Group is the average of %Answered of Controls in the Group.

The Risk Score of the lowest level Control Group is the  summation of the Risk Scores of the Controls in the Group.
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Assessments Domain Part 2 of 2

 View  Fields  Measures

Control Groups Control Groups/Controls

Control Type

Compliance Score

% Answered

Risk Score

Assessment Risk Details Risk Permanent ID

Risk Title

Risk Categories

Risk Description

Assessment Risk Owner

Overall Likelihood

Overall Impact

Inherent Risk Score

Residual Risk Score

Current Risk Score

Controls and Subcontrols

Mapped To Risks
Control Title Compliance Score

Control Description

Subcontrol Title

Subcontrol Description

Subcontrol Test Date

Is Applicable

Selected Choice Text

Responses Mapped To Risks Response Title Risk Reduction Percentage
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Response Owner

Response Action

Response Status

Response Last Updated

 View  Fields  Measures

Note: 

Control Group Name will show the lowest-level Control Group, Control Objectives (if applicable), and Controls. 

The Compliance Score of the lowest level Control Group is the average of the Compliance Scores of the Controls in the Group.

The % Answered of the lowest level Control Group is the average of %Answered of Controls in the Group.

The Risk Score of the lowest level Control Group is the  summation of the Risk Scores of the Controls in the Group.
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Controls Domain

Controls Domain

Views Fields Measure

Content Packs General Author

Description

Rationale/Comments

Title

Ownerships Owner

Ownership Name

Type

Workflow Details End

From

Status

Start

To

Transition Action

Type

Recurrence Notification Template

Recurrence

Tags Category

Description

Name

Comments Comment

Entered By

Entered Time

Applications Solution
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Content Packs Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12
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Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Content Packs Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8
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Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49
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Custom String 50

Custom Text 3

Custom Text 4

Content Packs Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59
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Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Groups General Description

Group Details

Identifier

Title

Tags Category

Description

Name

Applications Solution
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Control Groups Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13
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Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Control Groups Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8
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Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

223



Custom String 50

Custom Text 3

Custom Text 4

Control Groups Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

224



Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Control Objectives General Author Weight

Created Time

Objective

Identifier

Last Updated Time

Other

Title

Version

Refernces Name
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Tags Category

Description

Name

Documents Size

Caption

Content Type

Description

URL

Valid Until Date

When Uploaded

Who Uploaded

Ownerships Owner

Ownership Name

Type

Workflow Details End

From

Status

Start

To

Transition Action

Type

Category Name

Control Objectives Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3
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Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16
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Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Control Objectives Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26
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Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4
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Control Objectives Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62
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Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Controls General Control Type Weight

Created By

Created Time

Control Statement

Identifier

Last Update Time

Status

Title

Version

Additional Details Audience

Definitions
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Key Points

Other

Purpose

Risk drivers

Scope

Supporting Information

Test Procedure

Value Drivers

Guidance Guidance

References Name

Tags Category

Description

Name

Documents Caption

Size

Content Type

Description

Name

URL

Valid Until Date

When Uploaded

Who Uploaded

Risks ISO Domain Reference

Risk

Threat

Vulnerability
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Target Profiles Author

Created Time

Description

Updated Time

Title

Controls Paths Controls Paths Depth

Controls Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6
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Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Controls Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4
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Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43
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Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Controls Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54
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Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Subcontrols General Assessment Procedures Key Control

Author Weight
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Created

Description

Help Text

Identifier

Last Updated

Parent Control

Description

Title

Question Name

Question Text

Status

Version

Question Details Choice Text Choice Score

Comment Required Risk Score

Deficiency Required

Evidence Description

Evidence Required

Dependency Assessment Procedures Key Control

Author Question Type

Created Weight

Description

Help Text

Identifier

Last Updated

Parent Control

Description
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Title

Question Name

Question Text

Status

Version

References Name

Tags Category

Description

Name

Documents Caption

Size

Content Type

Description

URL

Valid Until Date

When Uploaded

Who Uploaded

Risks ISO Domain Reference

Risk

Threat

Vulnerability

Target Profiles Author

Created Time

Description

Updated Time

Title
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Assignments Assigned Assessment

Control

Program

Subcontrols Paths Subcontrols Paths Depth

Subcontrol Path Target Target Sub Controls Paths Depth

Subcontrol Reference Target Name

Subcontrols Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7
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Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Subcontrols Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4
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Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43
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Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Subcontrols Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54
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Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer
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Datafeeds Domain

Datafeeds Domain

View Fields Measure

Data Feeds Details Check Identification Check ID

Check Name Float 1

Created Time Float 2

Data Feed Comment Score

Data Feed Type

Entity Identification

Entity Name

First Seen Time

Host Name

IP Address

Last Seen Time

Data Feed Name

Owner

Source Name

Status

String 1

String 2

String 3

String 4

String 5

String 6

String 7

String 8
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String 9

String 10

Time Stamp 1

Time Stamp 2

Data Feeds

Documents
Caption

Description

Expires On

Size

Name

Uploaded By

Uploaded By First Name

Uploaded By Last Name

Uploaded By Middle

Name

Uploaded On

Data Feeds Histories Data Feed Comment Score

Data Feed Type

First Seen Time

Name

Status
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Entities Domain

Entities Domain

Views Fields

Entities(All Type) Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Last Updated

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Model

Organization Name

Product Name

Status

Serial Number

Version

Warranty Expiration Date

Warranty Reference

Entities Applications General Created By
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Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Accounts

Application Version

Internet Facing

Port(s)

Publisher

Entities Computers General Created By

Created Time
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Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Domain Name

Host Name

Processor Name

Roles

Installed Applications Application Type

Status

System Component

Update Status

Update Time
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Computersystems To Ports Comment

Computersystems To

Services
Account Name

Comment

Operational State

Operational Status

Path Name

Service Type

Start Mode

Network Interfaces Alias Addresses

Caption

Description

DHCP Enabled

DHCP Lease Expires

DHCP Lease Obtained

DNS Servers

Element Name

Group Addresses

Install Date

IP Address

LAN ID

MAC Address

Friendly Name

Name Format

Network Zone

Operational Status
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System Name

Time Of Last State Change

WINS Server

Wireless Status

Filesystems Caption

Case Preserved

Case Sensitive

Code Set

Compression Method

Description

Element Name

Encryption Method

File System Type

Install Date

Unique Name

Operational Status

Root

Time Of Last State Change

Local Accounts Description

Disabled Flag

Domain

Full Name

Install Date

Local Account Flag

Lockout Flag
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Name

Password Changeable Flag

Password Expires Flag

Password Required Flag

Screensaver Active Flag

Screensaver Secure Flag

Status

Type

Local Groups Caption

Description

Domain

Unique Name

Status

Type

Logical Devices Caption

Description

Element Name

Install Date

Unique Name

Operational Status

Time Of Last State Change

Networks Network Address

DNS servers

Managed

Observed

Wireless Channel
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Wireless Encryption

Wireless Network name

Wireless Security mode

Wireless SSID Broadcast

Operating Systems Caption

Description

Distributed

Element Name

Enabled State

Install Date

Last Boot Up Time

Local Date Time

Name

Operational Status

Serial Number

Time Of Last State Change

Version

Version Name

Ports Description

Port Number

Protocol

Unique Name

Port To Network Interfaces Comment

Procs Caption

Description

Element Name
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Handle

Install Date

Name

Termination Date

Time Of Last State Change

Services Description

Name

Network Shares Allow Maximum Flag

Description

Unique Name

Path

Status

Type

Entities Source Information Source Caption

Connector Name

Connector Type

Icon

Entities Data General Created By

Created Time

Data Source(s)

Discovery Method

Entity Name

Entity Description

Entity Subtype

Entity Type

First Seen Date
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Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Archive Location

Archive Media

Archive Method

Is Archived

Authorized Users

Data Is Encrypted

Encryption Method

Data Format

Last Complete Archive Date

Storage Media

Password Owner

Is Data Password Protected

Data Path

Entities Devices General Created By

Created Time

Data Source(s)
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Discovery Method

Entity Name

Entity Description

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Firmware Version

Entities Engagements General Created By

Created Time

Data Source(s)

Discovery Method

Entity Name

Entity Description

Entity Subtype

Entity Type
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First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Default Flag

Service Type

Vendor Service Tier

Entities Groups General Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference
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Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Business Category

Common Name

Created

Domain Name

Element Name

Instance Type

Last Updated

Object GUID

SAM Account Name

Entities Mobile Devices General Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date
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Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Additional Mobile Number

Bluetooth

Bluetooth Address

Carrier Name

Device Network Type

Display

Integrated Circuits Identifier (ICCID)

International mobile Equipement IdentIty (IMEI)

International mobile Equipement IdentIty Software Version

(IMEISV)

Domain Name

Host Name

Main Camera

Memory

Mobile Number

Model Number

Modem Firmware
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Processor Name

Roles

Service State

Wi-Fi

Wi-Fi Address

Entities Networks General Created By

Created Time

Data Source(s)

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Network Address

DNS Servers

Managed
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Observed

Wireless Channel

Wireless Encryption

Wireless Network Name

Wireless Security Mode

Wireless SSID Broadcast

Entities People General Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference
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Description Business Category

Email Address

Employee Number

Employee Type

Home Phone

Mobile

Preferred Language

Telephone Number

Title

Entities Processes General Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version
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Warranty Expiration Date

Warranty Reference

Description Business Function

Department

Responsibile Person

Entites Vendors General Created By

Created Time

Data Source(s)

Discovery Method

Entity Description

Entity Name

Entity Subtype

Entity Type

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Product Name

Serial Number

Status

Version

Warranty Expiration Date

Warranty Reference

Description Login Message

Preferred Vendor
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Activated

Data Access

Vendor Previous Name

Vendor Relationship

Vendor Status

Vendor Tier

Type

Entities Classification Accountability

Availability

Business Criticality

Confidentiality

Integrity

Security Classification

Entities Addresses Address

Address Name

Address Type

Building

City

Country

Floor

Postal Code

Region

State/Province

Entities Documents Caption

Description

Expires On
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Name

Size

Uploaded by

Uploaded on

Entities Hierarchy Hierarchy Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Entities Ownerships Entity Type
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Entity Name

Owner

Ownership Type

Entites Relationships Entity Subtype

Entity Type

Name

Relationship Name

Entities Tag Tag Category

Tag Name

Entities Classification Histories Changed Attribute

New Value

Old Value

Operation Time

Operation Type

Who

Entities Custom Attributes 1

Custom Date 1

Custom Date 2

Custom Date 3

Custom Encrypted String 1

Custom Encrypted String 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2
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Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23
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Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Entities Custom Attributes 2 Custom Date 4

Custom Date 5

Custom Date 6

Custom Encrypted String 6

Custom Encrypted String 7

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

268



Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Entities Custom Attributes 3 Custom Date 7

Custom Date 8

Custom Date 9

Custom Encrypted String 11

Custom Encrypted String 12

Custom Encrypted String 13

Custom Encrypted String 14
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Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70
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Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Measures

Entities Applications Description IPv4 Address

Entities Computers Computersystems To Ports Source

Computersystems To

Services
Source

Network Interfaces Data Source

DHCP Server

Enabled Default

Enabled State

Gateway

IPv4 Address

Max Data Size

Network Address

Prefix Length

Primary WINS Server
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Protocol IF Type

Requested State

Secondary WINS Server

Subnet Mask

Filesystems Available Space

Block Size

Cluster Size

Enabled Default

Enabled State

File System Size

Max File Name Length

Persistence Type

Requested State

Local Accounts Data Source

Screensaver Timeout

Local Groups Data Source

Logical Devices Availability

Enabled Default

Enabled State

Networks DHCP Server

External IP address

Gateway

IP Address End

IP Address Start

Primary WINS server
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Secondary WINS server

Subnet Mask

Operating Systems Current Time Zone

Enabled Default

Max Number Of Processes

Max Process Memory Size

Max Processes Per User

Number Of Licensed Users

OS Type

Requested State

Size Stored In Paging Files

Total Swap Space Size

Total Virtual Memory Size

Total Visible Memory Size

Port To Network Interfaces Source

Procs Execution State

Logical Port

Workingset Size

Network Shares Data Source

Maximum Allowed

Entities Source Information License ID

Entities Groups Description Group Type

Entities Networks Description DHCP Server

External IP Address

Gateway

IP Address End
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IP Address Start

Primary WINS Server

Secondary WINS Server

Subnet Mask

Entities Costs And Impacts Annual Maintenance($ per year)

Availability Impact Cost Per hour($)

Average Remediation Time (days)

Business Value

Business Value Hours($)

Confidentiality Impact Cost Per Database($)

Confidentiality Impact Cost Per Record($)

Data Integrity Cost($)

Hardware Replacement Cost($)

Number Of Users

Operating Budge($ per day)

Single User Availability Cost($ per day)

Software Replacement Cost($)

Entities Documents Version

Entities Custom Attributes 1 Custom Number 1

Custom Number 2

Custom Number 3

Custom Rational Number 1

Custom Rational Number 2

Entities Custom Attributes 2 Custom Number 4

Custom Number 5

Custom Number 6
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Custom Rational Number 3

Custom Rational Number 4

Entities Custom Attributes 3 Custom Number 7

Custom Number 8

Custom Number 9

Custom Rational Number 5

Custom Rational Number 6

Vulnerability Compensating

Controls
Name

Status

Last Updated
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Exceptions Domain

Exceptions Domain

View Fields Measure

Exceptions Control Override Compliance Score

Current Workflow Stage Name

Exception Name

Exception Number

Expiration

Next Review

Program

Reason For Exception

Recurrence End Date

Recurrence Start Date

Requested By

Risk

Start

Status Modified By

Exceptions Comments Commented By

Commented By First Name

Commented By Last Name

Commented By Middle Name

Comment

Posted

Exceptions Documents Description Version

Name

Uploaded By
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Uploaded On

Caption

Size

Expires On

Compensating Controls Assessment

Subcontrol

Compensating Control

Statement

Compensating Control Title

Created By

Last Updated

Exceptions Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3 Exceptions Custom Attributes 2

Custom Encrypted String 4 Custom Number 4

Custom Encrypted String 5 Custom Number 5

Custom Flag 1 Custom Number 6

Custom Flag 2 Custom Rational Number 3

Custom Flag 3 Custom Rational Number 4

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2
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Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Exceptions Custom Attributes

2
Custom Date 4
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Custom Date 5

Custom Date 6

Custom Encrypted String 6

Custom Encrypted String 7

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39
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Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Exceptions Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15
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Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5
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Custom Text 6

Entities Created By Accountability Impact

Creation Time Annual Maintenance

Data Source(s) Availability Impact

Entity Description Availability Impact Cost Hours

Discovery Method Average Remediation Time Days

Entity Subtype Business Value

Entity Type Business Value Hours

First Seen Date
Confidentiality Impact Per

Database

Installation Date Confidentiality Impact Per Record

Maintenance Date Confidentiality Impact

Maintenance Reference Criticality

Manufacturer Data Integrity Cost

Model Hardware Replacement Cost

Entity Name Integrity Impact

Organization Name Number Of Users

Product Name Operational Budget

Security Classification Single User Availability Cost

Serial Number Software Replacement Cost

Status

Version

Warranty Expiration Date

Warranty Reference

Entities Hierarchy Hierarchy Description

Level 2

Level 3
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Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Exceptions Workflow Owners Current Workflow Stage Name

Workflow Owner

Workflow Owner First Name

Workflow Owner Last Name

Workflow Owner Middle Name

Exceptions Workflow Histories Action

Comment

Date

Status

Target User

To Stage

User
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User First Name

User Last Name

User Middle Name

Findings Control

Created By

Created On

Current Stage

Entity

Finding Description

Finding Title

Impact

Individual

Last Modified By

Last Modified Date

Likelihood

Residual Impact

Residual Likelihood

Residual Risk Score

Risk Score

Status

Team

Spacer
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Finding Domain

Findings Domain

View Fields Measure

Findings Control

Created By

Created On

Current Stage

Entity

Finding Description

Individual

Last Modified By

Last Modified Date

Finding Status

Finding Team

Finding Title

Entities Created By Accountability Impact

Created Time Annual Maintenance

Entity Description Availability Impact

Discovery Method Availability Impact Cost Hours

Entity Subtype Average Remediation Time Days

Entity Type Business Value

First Seen Date Business Value Hours

Installation Date
Confidentiality Impact Cost Per

Database

Maintenance Date Confidentiality Impact Cost Per Record

Maintenance Reference Confidentiality Impact
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Manufacturer Criticality

Model Data Integrity Cost

Organization Name Hardware Replacement Cost

Product Name Integrity Impact

Security Classification Number Of Users

Serial Number Operational Budget

Version Single User Availability Cost

Warranty Expiration Date Software Replacement Cost

Warranty Reference

Data Source(s)

Entities Hierarchy Hierarchy Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 12

Level 13

Level 14

Level 15

Path

Root
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Entities Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Category

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13
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Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Entities Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8
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Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49
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Custom String 50

Custom Text 3

Custom Text 4

Entities Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60
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Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Findings Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5
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Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21
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Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Findings Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32
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Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Findings Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13
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Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68
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Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Risk Assessments Impact

Likelihood

Residual Impact

Residual Likelihood

Residual Risk Score

Risk Score

Responses Action Implementation Cost

Comment Override Compliance Score

End Date Time To Implement

Mitigation Status

Owning Organization

Start Date

Response Title

Tickets Disposition Progress

End

Exception Expiration Date

Owner
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Owner First Name

Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority

Start

Status

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

Findings Documents Caption Version

Description

Expires On

Uploaded By

Name

Uploaded On

Size

Findings Workflow Owners Current Workflow Stage

Workflow Owner

Owner First Name

Owner Last Name

Owner Middle Name

Findings Workflow Histories Action
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Comment

Date

From Stage

Target User

To Stage

User

User First Name

User Last Name

User Middle Name

Findings Change Histories Change

When

Who

Who First Name

Who Last Name

Who Middle Name

Responses Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2
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Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23
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Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Responses Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33
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Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Responses Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13
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Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69
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Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Assessments Archived Compliance Score

Assessment Owner Current Risk Score

Assessment Ownership Type Inherent Risk Score

Create Date Progress

Current Status Residual Risk Score

Due Date Simple Risk Score

End Date

Is Not Closed

Name

Version

Exceptions Compensating Controls Override Compliance Score

Control

Current Workflow Stage

Name

Exception Number

Exception Title

Expiration

Next Review
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Program

Reason For Exception

Recurrence End Date

Recurrence Start Date

Requested By

Risk

Start

Status Modified By

Programs Description Assessment Duration

Program Name

Program Owner

Program Team

Program Type

Recurrence

Workflow Name

Spacer

304



Incidents Domain

Incidents Domain

Views Fields Measure

Incidents Due Date

Incident Description

Incident Number

Incident Submitter

Incident Subtype

Incident Type

Time Detected

Time Ended

Time Received

Time Started

Time Updated

Incident Title

Entities Created By Accountability Impact

Created Time Annual Maintenance

Entity Description Availability Impact

Entity Subtype Availability Impact Cost Hours

Entity Type Average Remediation Time Days

Discovery Method Business Value

First Seen Date Business Value Hours

Installation Date
Confidentiality Impact Cost Per

Database

Maintenance Date Confidentiality Impact Cost Per Record

Maintenance Reference Confidentiality Impact

Manufacturer Criticality
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Model Data Integrity Cost

Entity Name Hardware Replacement Cost

Organization Name Integrity Impact

Product Name Number Of Users

Security Classification Operating Budget

Serial Number Single User Availability Cost

Version Software Replacement Cost

Warranty Expiration Date

Warranty Reference

Data Source(s)

Entities Hierarchy Hierarchy Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path
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Root

Incidents Comments Commented By

Commented By First Name

Commented By Last Name

Commented By Middle Name

Comments

Comment Posted

Incident Additional Actions Additional Actions Estimated Cost

Availability Affected Impact

Business Criticality Likelihood

Cause Analysis

Confidentiality Affected

Current Stage

Integrity Affected

Last Updated

Preventive Measures

Priority

Severity

Related Incidents Related Incident Description

Related Due Date

Related Incident Number

Related Incident Submitter

Related Incident Subtype

Related Incident Title

Related Incident Type

Related Time Detected
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Related Time Ended

Related Time Received

Related Time Started

Incident Risk Assessment Assigned To Progress

Control

Status

Risk Assessments Ownerships Owner

Ownership Type

Incident Risk Summary Incident Impact

Incident Likelihood

Incident Risk

Incidents To Actions Action Description

Action Summary

Action Time

Resolution

Status

User First Name

User Last Name

User Middle Name

Tickets Disposition Percent Complete

End

Exception Expiration Date

Owner

Owner First Name

Owner Last Name

Owner Middle Name
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Planned End

Planned Start

Priority

Stage

Start

Status

Ticket Description

Ticket Identifier

Ticket Title

Ticket Type

Threats Threat Category Name

Threat Description

Threat Title

Incident Ownership Owner Name

Ownership Type

Incidents Current Workflow

Stakeholder
Current Workflow Stage Name

Workflow Owner

Workflow Owner First Name

Workflow Owner Last Name

Workflow Owner Middle

Name

Team

Incident Workflow History Action

Comment

Date

Owner

Status
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Target User

To Stage

Incidents To Controls Referenced Object Type

Referenced Object Title

Controls Audience Alpha

Created By Beta

Created Time Weight

Definitions

Control Statement

Identifier

Key Points

Last Update Time

Other

Purpose

Scope

Status

Supporting Information

Control Title

Version

Controls Paths Controls Paths Depth

Subcontrols Assessment Procedures Key Control

Author Question Type

Created Weight

Help Text

Identifier

Last Updated
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Parent Control

Subcontrol Description

Subcontrol Title

Question Name

Question Text

Status

Question Description

Version

Subcontrols Paths Subcontrol Path Depth

Incidents Documents Caption Version

Name

Description

Expires On

Uploaded By

Uploaded On

Size

Incidents Change Histories Change

When

Who

Who First Name

Who Last Name

Who Middle Name

Incidents Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1
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Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18
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Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Incidents Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29
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Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Incidents Custom Attributes 3 Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9
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Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66
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Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer
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Programs Domain

Programs Domain

View Fields Measure

Programs Description Assessment Duration

Program Name

Program Owner

Program Type

Recurrence

Team

Workflow Name

Programs Comments Commented By

Commented By First Name

Commented By Last Name

Commented By Middle

Name

Comments

Posted

Programs Documents Caption Version

Description

Expires On

Uploaded By

Name

Size

Uploaded On

Controls Audience Alpha

Controls Paths Beta

Created By Depth
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Created Time Weight

Definitions

Control Statement

Identifier

Key Points

Last Updated Time

Other

Purpose

Scope

Status

Supporting Information

Title

Version

Subcontrols Assessment Procedures Depth

Author Key Control

Created Question Type

Help Text Weight

Identifier

Last Updated

Parent Control

Control Description

Control Title

Question Name

Question Text

Status

Subcontrols Paths
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Version

Assessments Archived Compliance Score

Created Date Current Risk Score

Current Status Inherent Risk Score

Due Date Progress

End Date Residual Risk Score

Is Not Closed Simple Risk Score

Name

Version

Entities Created By Accountability Impact

Created Time Annual Maintenance

Discovery Method Availability Impact

Entity Description Availability Impact Cost Hours

Entity Name Average Remediation Time Days

Entity Owner Name Business Value

Entity Ownership Type Business Value Hours

Entity Subtype
Confidentiality Impact Cost Per

Database

Entity Type Confidentiality impact Cost Per Record

First Seen Date Confidentiality Impact

Installation Date Criticality

Maintenance Date Data Integrity Cost

Maintenance Reference Data Source(s)

Manufacturer Hardware Replacement Cost

Model Integrity Impact

Organization Name Number Of Users

Product Name Operational Budget
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Security Classification Single User Availability Cost

Status

Serial Number Software Replacement Cost

Version

Warranty Expiration Date

Warranty Reference

Entities Hierarchy Hierarchy Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Programs Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3
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Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16
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Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Programs Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27
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Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Programs Custom Attributes

3
Custom Date 7 Custom Number 7
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Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64
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Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer
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Risk Domain

Risks Domain

View Fields Measure

Risks ISO Reference
Annualized Rate Of

Occurrence

Permanent ID Availability Exposure

Risk Title Confidentiality Exposure

Threat Integrity Exposure

Threat Category Impact

Vulnerability Likelihood

Controls Audience Alpha

Control Path Beta

Control Title Depth

Control Statement Weight

Created By

Created Time

Definition

Identifier

Key Points

Last Updated Time

Other

Purpose

Scope

Status

Supporting Information

Version

Risks Controls Control Type
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Reference Control Title

Subcontrols Assessment Procedures Depth

Author Key Control

Created Weight

Description

Help Text

Identifier

Last Updated

Question Name

Question Text

Status

Subcontrol Title

Subcontrols Paths

Version

Risks Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3
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Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24
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Custom String 25

Custom Text 1

Custom Text 2

Risks Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35
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Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Risks Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11
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Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72
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Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer
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Tickets Domain

Tickets Domain

View Fields Measures

Tickets Disposition Progress

End

Exception Expiration Date

Owner

Owner First Name

Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority

Start

Status

Risk

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

Tickets Workflow Owners Status

Ticket Owner First Name

Ticket Owner Last Name

Ticket Owner Middle Name

Ticket Owner User ID
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Workflow Owner

Tickets Workflow Histories Action

Date

Forced Transition

From Stage

Target User

To Stage

User

User First Name

User Last Name

User Middle Name

Workflow Comment

Tickets Change Histories Change

When

Who

Who First Name

Who Last Name

Who Middle Name

Tickets Comments Commented By

Commented By First Name

Commented By Last Name

Commented By Middle

Name

Comments

Posted

Tickets Documents Expires On Version

Caption
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Description

Uploaded By

Name

Size

Uploaded On

Tickets Linked Objects Title

Owner

Owner First Name

Owner Last Name

Owner Middle Name

Type

Tickets Linked To Entities Created By Status

Created Time

Data Source(s)

Discovery Method

Entity Name

Entity Subtype

Entity Type

Entity Description

First Seen Date

Installation Date

Maintenance Date

Maintenance Reference

Manufacturer

Model

Organization Name
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Product Name

Status

Serial Number

Version

Warranty Expiration Date

Warranty Reference

Tickets Linked To

Vulnerabilities
Acknowledged CVSS Score

Applicable

CVSS Access Complexity

CVSS Access Vector

CVSS Authentication

CVSS Availability Impact

CVSS Confidentiality Impact

CVSS Exploitability

CVSS Integrity Impact

CVSS Remediation Level

CVSS Report Confidence

Last Modified Time

Likelihood

Modified Date

Owner

Published Date

Secondary Source

Severity

Source Type

Status
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System Information

Vulnerability Comment

Vulnerability Description

Vulnerability Identifier

Vulnerability Title

Tickets Linked To Assessments Archived Compliance Score

Create Date Current Risk Score

Current Status Inherent Risk Score

Due Date Progress

End Date Residual Risk Score

Is Not Closed Simple Risk Score

Name

Version

Tickets Linked To Findings Control

Created By

Created On

Current Stage

Entity

Finding Description

Finding Status

Finding Team

Finding Title

Impact

Individual

Last Modified By

Last Modified Date
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Finding Likelihood

Residual Likelihood

Residual Impact

Residual Risk Score

Risk Score

Tickets Linked To Responses Action Implementation Cost

Comment Override Compliance Score

End Date Time To Implement

Mitigation Status

Owning Organization

Response Title

Start Date

Tickets Linked To Incidents Additional Actions Estimated Cost

Availability Affected Impact

Business Criticality Likelihood

Cause Analysis

Confidentiality Affected

Current Stage

Due Date

Incident Description

Incident Number

Incident Submitter

Incident Subtype

Incident Title

Incident Type

Integrity Affected

Last Updated
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Preventive Measures

Priority

Severity

Time Detected

Time Ended

Time Received

Time Started

Time Updated

Tickets Linked To Subcontrols Assessment Procedures Key Control

Author Question Type

Created Weight

Help Text

Identifier

Last Updated

Measurement Rules

Nature

Parent Control

Question Description

Question Name

Question Text

Subcontrol Status

Subcontrol Description

Subcontrol Title

Version

Tickets Custom Attributes 1 Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2
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Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15
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Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Tickets Custom Attributes 2 Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26
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Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Tickets Custom Attributes 3 Custom Date 7 Custom Number 7
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Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64
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Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer
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Users and Roles Domain

Users and Roles Domain

View Fields Measures

Users Authentication External Status

Domain

First Name

Last Name

Middle Name

Status

User ID

Roles Role Description

Role Display Name

Role Name

Role Permissions Permission Description

Permission Name

Team Details Team Display Name Number of Team Members

Managed By

Team Name

User Delegations End Date

First Name

Last Name

Middle Name

Start Date

Access Filters Filter Description

Filter Name

Filter Type
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User Events Category

Event Location

Event Name

Event Time

Event Title

Level

Object Type

Severity

Users Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5
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Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Users Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

347



Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42
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Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Users Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53
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Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer

350



351



Vulnerabilities-Definition Domain

Vulnerabilities-Definition Domain

View Fields Measure

Vulnerabilities Acknowledged Exploits

Applicable

Comment

Last Modified Time

Likelihood

Modified Date

Owner

Published Date

Secondary Source

Severity

Source Type

Status

System Information

Vulnerability Description

Vulnerability Identifier

Vulnerability Title

CVSS v2.0 Scores CVSS Access Complexity CVSS Score

CVSS Access Vector

CVSS Authentication

CVSS Availability Impact

CVSS Confidentiality Impact

CVSS Exploitability

CVSS Integrity Impact
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CVSS Remediation Level

CVSS Report Confidence

Vulnerabilities Identifications Identification Description

Identification Name

Source

More Information Data

Links

Type

Name

Exploits CVE Reference

Description

Name

Platform

Port

Date Published

Reliability

Type

Vulerabilities References Reference Name

Vulnerabilities Risks Reference Number

Risk Name

Tickets Disposition Progress

End

Exception Expiration Date

Owner

Owner First Name
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Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority

Start

Status

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

Vulnerabilities CPEs CPE Description

CPE URI

Edition

Full Name

Language

Modified Date

Product

Type

Update

Vendor

Version

Vulnerabilities Patches Comments

Full Description

Last Modified Time
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Managed By

Patch Name

Publisher

Release Date

Severity

Short Description

Type

URL

Version

Vulnerabilities List

Vulnerabilities Change

Histories
Changed Attribute

New Value

Old Value

Operation

When

Who

Who First Name

Who Last Name

Who Middle Name

Vulnerabilities Custom

Attributes 1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1
Custom Rational

Number 1

Custom Encrypted String 2
Custom Rational
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Number 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17
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Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Vulnerabilities Custom

Attributes 2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6
Custom Rational

Number 3

Custom Encrypted String 7
Custom Rational

Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26
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Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4
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Vulnerabilities Custom

Attributes 3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11
Custom Rational

Number 5

Custom Encrypted String 12
Custom Rational

Number 6

Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61
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Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Spacer

Vulnerability Compensating

Controls
Name

Protection Risk Percentage

Detection Risk Percentage

Total Risk Reduction Percentage

Last Updated

Risk Score Reduction Details Total Deduction Percentage Reduction

Total Protection Percentage Reduction

Total Percentage Reduction

Total Risk Reduction for the Vulnerability (Compensating Controls Risk
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Reduction Value)

Risk Score Remained (Risk not Reduced by Compensating Controls

Value)
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Vulnerabilities-Inferred Domain

Vulnerabilities-Inferred Domain

View Fields Measure

Vulnerabilities Inferred Acknowledged

Applicable

Comment

Early Warning

Last Modified Time

Latest Patch Date

Likelihood

Modified Date

Owner

Published Date

Record Type

Secondary Source

Severity

Status

System Info

Vulnerability Description

Vulnerability Identifier

Vulnerability Title

CVSS v2.0 Scores CVSS Access Complexity CVSS Score

CVSS Access Vector

CVSS Authentication

CVSS Availability Impact

CVSS Confidentiality Impact
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CVSS Exploitability

CVSS Integrity Impact

CVSS Remediation Level

CVSS Report Confidence

Vulnerabilities Identifications Identification Description

Identification Name

Source

Exploits CVE Reference

Description

Name

Platform

Port

Date Published

Reliability

Type

More Information Data

Links

Name

Type

Vulerabilities References Reference Name

Vulnerabilities Risks Reference Number

Risk Name

Tickets Disposition Progress

End

Exception Expiration Date

Owner
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Owner First Name

Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority

Status

Start

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Type

Ticket Title

Vulnerabilities CPEs CPE Description

CPE URI

Edition

Full Name

Language

Modified Date

Product

Type

Update

Vendor

Version

Vulnerabilities Patches Comments

Full Description

Last Modified Time
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Patch Name

Publisher

Managed By

Release Date

Severity

Short Description

Type

URL

Version

Vulnerabilities List

Vulnerabilities Change Histories Changed Attribute

New Value

Old Value

Operation

When

Who

Who First Name

Who Last Name

Who Middle Name

Vulnerabilities Custom Attributes

1
Custom Date 1 Custom Number 1

Custom Date 2 Custom Number 2

Custom Date 3 Custom Number 3

Custom Encrypted String 1 Custom Rational Number 1

Custom Encrypted String 2 Custom Rational Number 2

Custom Encrypted String 3

Custom Encrypted String 4
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Custom Encrypted String 5

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20
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Custom String 21

Custom String 22

Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Vulnerabilities Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31
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Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Vulnerabilities Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6
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Custom Encrypted String 13

Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

369



Custom String 69

Custom String 70

Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

Entities Entity Subtype Accountability Impact

Entity Type Annual Maintenance

Created By Availability Impact

Created Time Availability Impact Cost Hours

Description Average Remediation Time Days

Discovery Method Business Value

First Seen Date Business Value Hours

Installation Date
Confidentiality Impact Cost Per

Database

Maintenance Date Confidentiality impact Cost Per Record

Maintenance Reference Confidentiality Impact

Manufacturer Criticality

Model Data Integrity Cost

Name Hardware Replacement Cost

Organization Name Integrity Impact

Product Name Number Of Users

Security Classification Operational Budget

Serial Number Single User Availability Cost

370



Version Software Replacement Cost

Warranty Expiration Date

Data Source(s)

Warranty Reference Status

CVSS v3.0 Scores Attack Vector Overall Score

Attack Complexity

Privilage Required

User Interaction

Scope

Cofidentiality

Integrity

Availability

Modified Attack Vector

Modified Attack Complexity

Modifies Privilage Required

Modified User Interaction

Modified Scope

Confidentiality Requirement

Integrity Requirement

Availability Requirement

Modified Confidentiality

Modified Integrity

Modified Avaiability

Exploit Code Maturity

Remediation Level

Report Confidence
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Spacer
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Vulnerabilities-Inheritances Domain

Vulnerabilities-Instances Domain

View Fields Measure

Vulnerabilities Abstract Source Flags

Analysis Vulnerability Flags

Assessment Check Name

Assessment Check System

CVSS Target Distribution

CVSS Vector

CVSS Version

Default Severity

Deprecated Flag

Duplicated Flag

Early Warning Flag

Identifier

Last Modified Time

Likelihood

Modified Date

Published Date

Record Type

Recovery

Source

Vulnerability Identifier

Vulnerability Description

Vulnerability Title

CVSS v2.0 Scores CVSS Access Complexity CVSS Score
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CVSS Access Vector

CVSS Authentication

CVSS Availability Impact

CVSS Confidentiality Impact

CVSS Exploitability

CVSS Integrity Impact

CVSS Remediation Level

CVSS Report Confidence

Exploits CVE Reference

Description

Name

Platform

Port

Date Published

Reliability

Type

Vulnerability Identification Identification Description

Identification Name

Source

More Information Data

Links

Name

Type

Vulnerabilities References Name

Vulnerabilities Risks Reference Number

Risk Name
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Tickets Disposition Progress

End

Exception Expiration Date

Owner

Owner First Name

Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority

Start

Status

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

CPEs CPE Name

CPE URI

Description

Edition

Language

Modified Date

Product

Type

Update

Vendor
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Version

Patches Comments

Full Description

Last Modified Time

Patch Name

Patch Type

Managed By

Publisher

Release Date

Severity

Short Description

Source ID

URL

Version

Vulnerability List

Vulnerabilities Change Histories Changed Attribute

New Value

Old Value

Operation

When

Who

Who First Name

Who Last Name

Who Middle Name

Applications Application Status Antivirusupdate ID

Application Type Application Data Source
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System Component Flag

Update Status

Update Time

Computersystems To Ports Association Comment Source

Computersystems To Services Account Name Source

Association Comment

Operational State

Operational Status

Path Name

Service Type

Start Mode

Entities Data Source(s) Benchmark Flags

CN Business Cost

Container Level 1 CVSS Score

Container Level 2 Entity Number

Container Level 3 Entity Status

Container Level 4 Impact

Container Level 5 Initial Risk Score

Container Level 6 Likelihood

Created By Replacement Cost

Created Time Risk

CVSS Collateral DMG Potential Status

DC Time To Fix

Deleted Flag

Entity Description

Entity Name
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Entity Subtype

Entity Tag

Entity Type

Discovery Method

Distinguished Name

Division

First Seen Date

Hidden Flag

Installation Date

Internal Flag

Last Modification Time

Last Seen Date

Maintenance Date

Maintenance Reference

Manufacturer

Model

Organization Name

Product Name

Product Version

Serial Number

Subdivision

Tangible Flag

Update Finding

Version

Warranty Expiration Date

Warranty Reference

Entities Classification Accountability
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Availability

Confidentiality

Business Criticality

Integrity

Classification Label

Entities To Vulnerabilities Association Comment AV Flags

Created By Calculated Score

Created Time Likelihood

Detail Risk Score

Discovery Method Scores

External Catalog ID Source

File Name

First Seen Time

Fixed Time

Issue ID

Last Modified Time

Last Scan Time

Last Seen Time

Line Number

Location

Noise Flag

Patch Status

Processed

Resolved By

Resolved Comment

Resolved Status
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Resolved Time

Risk Flag

Secondary Source

Severity

Test URL

Total Exposure

Entities Hierarchy Hierarchy Description

Level 2

Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Entity Ownerships Owner

Ownership Type

Network Interfaces Alias Addresses Data Source
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Caption DHCP Server

Description Enabled Default

DHCP Enabled Enabled State

DHCP Lease Expires Gateway

DHCP Lease Obtained IPv4 Address

DNS Servers Max Data Size

Element Name Network Address

Group Addresses Prefix Length

Install Date Primary WINS Server

IP Address Protocol LF Type

LAN ID Requested State

MAC Address Secondary WINS Server

Friendly name Subnet Mask

Name Format

Network Zone

Operational Status

System Name

Time Of Last State Change

WINS Server

Wireless Status

Operating Systems Description Current Time Zone

Distributed Enabled Default

Element Name Enabled State

Install Date Max Number Of Processes

Last Boot Up Time Max Process Memory Size

Local Date Time Max Processes Per User

Operating System Name Number Of Licensed Users
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Operational Status OS Type

OS Caption Requested State

Serial Number Size Stored In Paging Files

Time Of Last State Change Total Swap Space Size

Version Total Virtual Memory Size

Version Name Total Visible Memory Size

Ports Port Description

Port Name

Port Number

Protocol

Services Service Description

Name

Source info Caption License ID

Connector Name

Connector Type

Icon

Vulnerabilities To Endpoints Association Comment Source

Vulnerabilities Custom Attributes

1
Custom Date 1 Custom Number 2

Custom Date 2 Custom Number 3

Custom Date 3 Custom Rational Number 1

Custom Encrypted String 1 Custom Rational Number 2

Custom Encrypted String 2

Custom Encrypted String 3

Custom Encrypted String 4

Custom Encrypted String 5
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Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22
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Custom String 23

Custom String 24

Custom String 25

Custom Text 1

Custom Text 2

Vulnerabilities Custom Attributes

2
Custom Date 4 Custom Number 4

Custom Date 5 Custom Number 5

Custom Date 6 Custom Number 6

Custom Encrypted String 6 Custom Rational Number 3

Custom Encrypted String 7 Custom Rational Number 4

Custom Encrypted String 8

Custom Encrypted String 9

Custom Encrypted String 10

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Flag 10

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32
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Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38

Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 3

Custom Text 4

Vulnerabilities Custom Attributes

3
Custom Date 7 Custom Number 7

Custom Date 8 Custom Number 8

Custom Date 9 Custom Number 9

Custom Encrypted String 11 Custom Rational Number 5

Custom Encrypted String 12 Custom Rational Number 6

Custom Encrypted String 13
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Custom Encrypted String 14

Custom Encrypted String 15

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom String 51

Custom String 52

Custom String 53

Custom String 54

Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70
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Custom String 71

Custom String 72

Custom String 73

Custom String 74

Custom String 75

Custom Text 5

Custom Text 6

CVSS v3.0 Scores Attack Vector Overall Score

Attack Complexity

Privilege Required

User Interaction

Scope

Confidentiality

Integrity

Availability

Modified Attack Vector

Modified Attack Complexity

Modifies Privilege Required

Modified User Interaction

Modified Cofidentiality

Modified Integrity

Modified Availability

Exploit Code Maturity

Remediation Level

Report Confidence

Vulnerability Enhanced Score Access Complexity Days Open
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Access Vector Denominator

Authentication Exploit Factor

Availability Numerator

Confidentiality Enhanced Score

Identifier

Integrity

Vulnerability Risk Score Entity Criticality
Number of Vulnerability

Instances

Entity Criticality Factor

Vulnerability Risk Factor

Vulnerability Risk Score
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Threat Domain

Tickets Domain

View Fields Measures

Threat Object Type Progress

Source

Title

Description

Owner

Severity

Likelihood

Risk

Status

Comment

Threats Linked To Entities Entity Description

Entity Manufacturer

Entity Tag

Entity Product Name

Entity Serial Number

Entity Status

Subtype

Discovery Method

Entities Classification Classification Levels

Entities Ownerships Owner

Ownership Type

Entities Hierarchy Hierarchy Description

Level 2
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Level 3

Level 4

Level 5

Level 6

Level 7

Level 8

Level 9

Level 10

Level 11

Level 12

Level 13

Level 14

Level 15

Path

Root

Network Interface IPV6 Address

MAC Address

IP Address

Operating System Description

Install Date

Operating System

Name

Serial Number

OS Type

Port Port Description

Port Name
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Port Number

Protocol

Services Services Description

Service Name

Source Info Caption

Connector Name

Connector Type

Icon

Threats Linked To Incidents Additional Actions

Avaiability Affected

Bussiness Criticality

Cause Analysis

Confidentiality Affected

Current Stage

Due Date

Incident Description

Incident Number

Incident Submitter

Incident Subtype

Incident Title

Incident Type

Incident Affected

Last Update

Preventive Measure

Priority Severity

Time Detected
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Time Ended

Time Started

Time Updated

Threats Linked To Tickets Disposition

End

Exception Expire Date

Owner

Owner First Name

Owner Last Name

Owner Middle Name

Planned End

Planned Start

Priority Start

Status

Ticket Description

Ticket Identifier

Ticket Stage

Ticket Title

Ticket Type

Threats Linked To

Vulnerabilities
Vulnerability Comment

CVSS Access Complexity

CVSS Access Vector

CVSS Authentication

CVSS Availability Impact

CVSS Confidentiality

Impact

CVSS Exploitability
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CVSS Integrity Impact

CVSS Remediation Level

CVSS Report Confidence

Identifier

Last Modified Time

Likelihood

Modified Date

Owner

Published Date

Secondary Score

Severity

Source Type

Status

System Information

Vulnerability Title

Acknowledged

Applicable

Threat Custom Attribute Custom Date 1

Custom Date 2

Custom Date 3

Custom Flag 1

Custom Flag 2

Custom Flag 3

Custom Flag 4

Custom Flag 5

Custom Long String 1
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Custom Long String 2

Custom Long String 3

Custom String 1

Custom String 2

Custom String 3

Custom String 4

Custom String 5

Custom String 6

Custom String 7

Custom String 8

Custom String 9

Custom String 10

Custom String 11

Custom String 12

Custom String 13

Custom String 14

Custom String 15

Custom String 16

Custom String 17

Custom String 18

Custom String 19

Custom String 20

Custom String 21

Custom String 22

Custom String 23

Custom String 24
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Custom String 25

Custom Text 1

Custom Text 2

Threat Custom Attribute 2 Custom Date 4

Custom Date 5

Custom Date 6

Custom Flag 5

Custom Flag 6

Custom Flag 7

Custom Flag 8

Custom Flag 9

Custom Long String 4

Custom Long String 5

Custom Long String 6

Custom String 26

Custom String 27

Custom String 28

Custom String 29

Custom String 30

Custom String 31

Custom String 32

Custom String 33

Custom String 34

Custom String 35

Custom String 36

Custom String 37

Custom String 38
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Custom String 39

Custom String 40

Custom String 41

Custom String 42

Custom String 43

Custom String 44

Custom String 45

Custom String 46

Custom String 47

Custom String 48

Custom String 49

Custom String 50

Custom Text 4

Custom Text 5

Threat Custom Attribute 3 Custom Date 7

Custom Date 8

Custom Date 9

Custom Flag 11

Custom Flag 12

Custom Flag 13

Custom Flag 14

Custom Flag 15

Custom Long String 51

Custom Long String 52

Custom Long String 53

Custom String 54
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Custom String 55

Custom String 56

Custom String 57

Custom String 58

Custom String 59

Custom String 60

Custom String 61

Custom String 62

Custom String 63

Custom String 64

Custom String 65

Custom String 66

Custom String 67

Custom String 68

Custom String 69

Custom String 70

Custom Text 5

Custom Text 6

397



398


